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Platform: wordpress
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Run ID: 2026-04-19T06-18-18-831Z

Scanned: 2026-04-19T06:30:53.340Z

Duration: 956s

This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 167 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 4 Significant revenue / SEO / UX impact

P2 (high) 510 Quality / ranking / trust degradation
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DIMENSION COUNT MEANING

P3 (medium) 416 Polish + optimization

"Do first" items 3 AI-flagged top priorities

Quick wins (< 30 min) 50 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _Unprotected login pages invite constant

hacking attempts that degrade site speed, increase hosting costs, and risk unauthorized access to your

inventory, customer data, and compliance documentation — all critical for a licensed cannabis retailer._

Page: https://terpbrosnyc.com/wp-login.php

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Lighthouse perf (mobile): 33/100 — _Mobile users abandon slow sites within 3

seconds; a 21-second wait will cause most mobile traffic to leave before seeing your menu, hours, or

products, directly reducing foot traffic and online orders._

Page: https://terpbrosnyc.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: ARIA dialog and alertdialog nodes should have an accessible name —

_Customers with visual disabilities cannot legally and safely verify their age through your gate, exposing you

to ADA compliance risk and lost sales from an underserved demographic._

Page: https://terpbrosnyc.com/

Effort: Quick win (< 30 min)

1. [P1] 🟠  HIGH Lighthouse bestPractices (mobile): 57/100 — _A low Best Practices score signals to search

engines and users that your site may be unsafe or poorly maintained, directly harming organic search

rankings and customer confidence—especially critical for a compliance-sensitive cannabis retailer._

Page: https://terpbrosnyc.com/

Effort: Moderate (1-3 hours)

1. [P1] 🟠  HIGH Lighthouse bestPractices (desktop): 59/100 — _A low Best Practices score can reduce

customer trust, increase bounce rates on mobile devices, and potentially trigger warnings in browsers —

especially important for a dispensary site where compliance and legitimacy are critical to conversions._

Page: https://terpbrosnyc.com/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH No JSON-LD schema — _Missing schema markup reduces your chances of appearing in

Google's rich snippets and product carousels, which drive clicks from local cannabis searches and product
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discovery._

Page: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 5 image(s) missing alt text — _Missing alt text reduces your search ranking for image-based

queries, hurts accessibility compliance (a legal risk in NY), and signals to search engines that your content is

incomplete — potentially lowering organic traffic to this newsletter page._

Page: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH Missing meta description — _A missing meta description reduces click-through rate from

search results, meaning fewer people visit this content even if it ranks well; for a community-focused

dispensary, lower engagement on newsletters and blog content hurts brand loyalty and repeat visits._

Page: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH No JSON-LD schema — _Without schema markup, your cannabis content ranks lower in

search results, and you miss opportunities to appear in rich snippets (like review stars or article summaries)

that drive clicks and traffic._

Page: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 5 image(s) missing alt text — _Missing alt text limits your SEO visibility for image searches,

reduces accessibility for disabled customers (a legal liability under ADA), and signals poor site quality to

Google, potentially lowering your ranking for cannabis product pages._

Page: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Effort: Quick win (< 30 min)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: security

Page URL: https://terpbrosnyc.com/wp-login.php

Rule: tier5.exposed.artifact

What it means (plain English)

Your WordPress login page (/wp-login.php) is publicly accessible and shows a 200 response, meaning anyone

on the internet can find and attempt to access your admin panel. While this is a common WordPress URL and
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attackers expect it to exist, leaving it completely open without any protection makes your site a routine target

for automated login attempts (called brute-force attacks) that consume server resources and can slow down

your storefront.

Why it matters for your business: Unprotected login pages invite constant hacking attempts that degrade site

speed, increase hosting costs, and risk unauthorized access to your inventory, customer data, and compliance

documentation — all critical for a licensed cannabis retailer.

Technical root cause: WordPress exposes /wp-login.php by default and your current server/firewall

configuration does not restrict or rate-limit access to this endpoint, leaving it open to anyone including

automated attack tools.

Recommended fix — step by step

1. Install Wordfence Security plugin (free tier sufficient): Go to WordPress Admin > Plugins > Add New, search

'Wordfence', install and activate.

2. In Wordfence settings, enable 'Two-Factor Authentication' and enforce it for all admin users: Wordfence >

All Options > User Management > Enable 2FA.

3. Enable Wordfence's login security: Wordfence > All Options > Login Security > set 'Enable login security' to

On, and set 'Force strong passwords' to On.

4. Optional: Rename the login URL to something non-standard using Wordfence or a plugin like WPS Hide

Login (go to Plugins > Add New > search 'WPS Hide Login' > install > set custom login slug in plugin

settings).

5. Configure your hosting provider's Web Application Firewall (WAF) if available: contact your host's support

and request they enable their DDoS/brute-force protection rules for /wp-login.php.

6. Review WordPress user accounts: Admin > Users, delete any unused admin accounts, and ensure only

trusted staff have editor or admin roles.

P1 — 4 findings

1. Lighthouse perf (mobile): 33/100

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: revenue

Page URL: https://terpbrosnyc.com/

Rule: tier8.lighthouse.perf-mobile

What it means (plain English)

Your mobile site takes 21.5 seconds for the largest visual element to appear on screen (Largest Contentful

Paint), when Google targets under 2.5 seconds. This delay happens because heavy images, unoptimized code,

or third-party scripts are loading before the main content. Visitors see a blank or partial page for 20+ seconds,

then your content suddenly appears.

Why it matters for your business: Mobile users abandon slow sites within 3 seconds; a 21-second wait will

cause most mobile traffic to leave before seeing your menu, hours, or products, directly reducing foot traffic

and online orders.

Technical root cause: Large uncompressed images, render-blocking JavaScript (possibly from plugins or ad

trackers), or oversized hero images are delaying when the main content becomes visible. WordPress plugins
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without lazy-loading or defer settings amplify this.

Recommended fix — step by step

1. Install ShortPixel Image Optimization (free tier) → Bulk optimize all images → enable WebP + AVIF formats →

verify LCP drops below 4s in Google PageSpeed Insights

2. Use Defer JavaScript (free WordPress plugin) → Settings → enable 'Delay non-critical JS' → test mobile

performance again

3. Go to WordPress Admin → Plugins → deactivate any unused plugins (especially sliders, pop-ups, or chat

widgets) → test Lighthouse again after each removal

4. Switch to a lightweight WordPress theme (e.g., Neve, Astra) if current theme lacks performance options →

compare Lighthouse scores before/after

5. Enable GZIP compression: contact your hosting provider (check WordPress Admin → General Settings →

Site Address) and request gzip be enabled on their server, or install Perfmatters plugin → Compression →

toggle GZIP on

6. Run Lighthouse again after each change → target LCP under 2.5s, TBT under 200ms

7. Add priority='high' lazy-loading to any below-fold images: in WordPress, use Smush plugin → Settings →

Lazy Load → enable

2. A11y: ARIA dialog and alertdialog nodes should have an accessible name

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: compliance

Page URL: https://terpbrosnyc.com/

Rule: tier9.a11y.aria-dialog-name

What it means (plain English)

Your age-gate popup (the overlay that appears when visitors arrive) is missing a label that screen reader users

can understand. Screen readers announce dialog boxes to assistive technology users, but without a name, they

hear only 'dialog' with no context. This is a serious accessibility issue because age verification is a legal

requirement in cannabis retail—customers using screen readers can't confirm they understand what they're

agreeing to.

Why it matters for your business: Customers with visual disabilities cannot legally and safely verify their age

through your gate, exposing you to ADA compliance risk and lost sales from an underserved demographic.

Technical root cause: The age-gate div element (#baag3-gate) has role="dialog" and aria-modal="true" but is

missing aria-label, aria-labelledby, or title attributes that would announce its purpose to assistive technology.

Recommended fix — step by step

1. Log in to WordPress admin → Elementor or your page builder (or edit the page in Code Editor if custom

HTML)

2. Locate the age-gate dialog element (search for 'baag3-gate' or 'age gate' in the page code)

3. Add aria-label="Age Verification Gate" to the div with id="baag3-gate" (or use aria-labelledby if the dialog

has a visible heading)

4. Test the fix using a screen reader (free: NVDA on Windows, VoiceOver on Mac) or axe DevTools browser

extension to confirm the dialog now announces its name

5. If using a WordPress plugin for age verification (like Age Gate, Popup Maker, or similar), check the plugin

settings for an 'Accessibility Label' field and enter 'Age Verification' there instead
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3. Lighthouse bestPractices (mobile): 57/100

Severity: P1 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/

Rule: tier8.lighthouse.bestPractices-mobile

What it means (plain English)

Your mobile site's Lighthouse Best Practices score is 57/100, meaning it's failing several web standards that

affect user trust, security, and browser compatibility. Common culprits include unoptimized images, missing

security headers, outdated JavaScript libraries, or third-party scripts that don't meet modern security

practices. This score indicates immediate technical debt that's visible to Google and affects how your site

ranks.

Why it matters for your business: A low Best Practices score signals to search engines and users that your

site may be unsafe or poorly maintained, directly harming organic search rankings and customer confidence—

especially critical for a compliance-sensitive cannabis retailer.

Technical root cause: WordPress sites often accumulate plugins, themes, and third-party scripts (ads,

analytics, payment processors) that introduce security vulnerabilities, deprecated JavaScript, or unoptimized

resources. The mobile LCP (Largest Contentful Paint) of 21.5 seconds also indicates severe image/server-side

performance issues.

Recommended fix — step by step

1. Run the full Lighthouse HTML report at /Users/markwallace/BKH/apex-sentinel/runs/2026-04-19T06-18-18-

831Z/lighthouse/terp-bros-nyc/lighthouse-mobile.html and document each failing audit (e.g., 'Missing

Security Headers', 'Outdated JavaScript Library').

2. In WordPress Admin → Settings → Reading, disable XML-RPC (often flagged as a security risk); then go to

Plugins → Installed and deactivate any unused plugins.

3. Install Wordfence Security plugin (free tier) → Firewall → check 'Enable Security Headers' to auto-add X-

Frame-Options, X-Content-Type-Options, and Strict-Transport-Security headers.

4. Check Admin → Plugins for any plugin with a red 'outdated' warning; update all plugins to latest versions,

testing on a staging site first.

5. Install Smush Pro or ShortPixel (free tier covers ~100 images/month) → Auto-compress and lazy-load all

images to reduce LCP below 4 seconds.

6. Review Admin → Settings → General and Admin → Plugins → Akismet/Jetpack to remove any unused third-

party scripts or integrations.

7. Use Google PageSpeed Insights (mobile tab) to re-test after each fix and confirm Best Practices score rises

above 85.

4. Lighthouse bestPractices (desktop): 59/100

Severity: P1 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://terpbrosnyc.com/

Rule: tier8.lighthouse.bestPractices-desktop

What it means (plain English)
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Your site's Lighthouse Best Practices score is 59 out of 100, well below the healthy target of 90. Lighthouse

audits check for issues like outdated JavaScript libraries, missing security headers, deprecated APIs, and

browser compatibility problems. This score suggests your site may be using older code patterns or plugins that

expose security or stability risks.

Why it matters for your business: A low Best Practices score can reduce customer trust, increase bounce

rates on mobile devices, and potentially trigger warnings in browsers — especially important for a dispensary

site where compliance and legitimacy are critical to conversions.

Technical root cause: WordPress sites often accumulate outdated plugins, theme code, or third-party scripts

that use deprecated methods or lack modern security practices. The score likely reflects a combination of

unpatched dependencies, missing HTTP security headers, or tracking/analytics code that doesn't meet current

standards.

Recommended fix — step by step

1. Log in to WordPress admin → Plugins → check each plugin for 'Update available' notices; update all plugins

immediately, especially security/SEO ones.

2. Go to Dashboard → check for yellow/red WordPress core update banner; apply any pending WordPress

version updates.

3. Install the plugin 'Security Headers' or 'WP Security Audit Log' to enable missing HTTP headers (X-Frame-

Options, Content-Security-Policy) — activate and configure with default settings.

4. Open Lighthouse report HTML file → filter for 'Best Practices' section → note specific failures (e.g.,

'Deprecated API', 'Unminified JavaScript'); note which plugin/theme each comes from.

5. If failures mention Google Analytics or third-party tracking, ensure you're using Google Tag Manager (not

old tracking code) via a plugin like 'MonsterInsights'.

6. Check Appearance → Customize → ensure no custom CSS or inline JavaScript contains outdated patterns; if

unsure, export code and ask your theme vendor to audit.

7. Run Lighthouse again after updates; if score remains below 80, escalate to your hosting company to verify

server-side headers and PHP version.

P2 — 510 findings

1. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your product pages and content don't include JSON-LD schema markup — a standardized format that tells

Google what your pages are about (e.g., product name, price, reviews). Without it, search engines have to

guess; they may miss key details like your product names, strain info, or availability.

Why it matters for your business: Missing schema markup reduces your chances of appearing in Google's

rich snippets and product carousels, which drive clicks from local cannabis searches and product discovery.
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Technical root cause: WordPress isn't automatically outputting JSON-LD blocks in the page head. Either the

theme doesn't generate it, or an SEO plugin isn't configured to do so.

Recommended fix — step by step

1. Install the free Yoast SEO or Rank Math plugin if not already active (Dashboard → Plugins → Add New,

search 'Yoast SEO').

2. In Yoast SEO, go to SEO → Settings → Integrations and enable 'Google Search Console' integration.

3. Navigate to each product post type (e.g., the Frozen Fire newsletter post) and scroll to the Yoast meta box

at the bottom; check that 'Schema' tab shows 'Product' or 'Article' is selected.

4. For product posts, fill in the 'Product name', 'Price', and 'Availability' fields in the Yoast schema section.

5. Go to SEO → Settings → Titles & Metas → Schema and confirm 'Organization' schema is enabled and your

dispensary name, address, phone are entered.

6. Use Google's Rich Results Test (https://search.google.com/test/rich-results) and paste your post URL to

verify schema is now rendering.

7. Save and republish affected posts to trigger re-crawl.

2. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

All 5 images on this newsletter page are missing alt text — short descriptions that screen readers read aloud to

blind or low-vision visitors, and that search engines use to understand what images show. Without alt text,

those images are invisible to both assistive technology and Google's crawlers, which means you lose SEO value

and exclude customers who rely on screen readers.

Why it matters for your business: Missing alt text reduces your search ranking for image-based queries, hurts

accessibility compliance (a legal risk in NY), and signals to search engines that your content is incomplete —

potentially lowering organic traffic to this newsletter page.

Technical root cause: Images were uploaded or embedded in WordPress without filling in the Alt Text field in

the media library. WordPress allows alt text to be left blank, so it defaults to none unless explicitly added during

upload or after the fact.

Recommended fix — step by step

1. In WordPress admin, go to Media Library and find the 5 images used on the Frozen Fire newsletter post.

2. For each image, click Edit, scroll to Alt Text field, and write a 5–10 word description of what the image shows

(e.g., 'Cannabis flower strain with crystalline trichomes' or 'Terp Bros founder holding award').

3. If images are embedded in the post already, go to Posts → Edit the Frozen Fire post, click each image in the

editor, and use the Image Settings panel on the right to add Alt Text.

4. After adding alt text to all 5 images, republish the post to ensure changes are live.

5. Use a free accessibility checker like WAVE (wave.webaim.org) to scan the page again and confirm all images

now have alt text.

3. Missing meta description
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https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/


Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page doesn't have a meta description—the 160-character summary that appears below the page

title in Google search results. Without it, Google generates one automatically from your page content, which is

often less compelling and may not highlight what makes this post interesting to potential visitors.

Why it matters for your business: A missing meta description reduces click-through rate from search results,

meaning fewer people visit this content even if it ranks well; for a community-focused dispensary, lower

engagement on newsletters and blog content hurts brand loyalty and repeat visits.

Technical root cause: WordPress doesn't automatically create meta descriptions for posts. The site likely uses

an SEO plugin (Yoast, Rankmath, etc.) but this specific post was published or edited without filling in the meta

description field.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'High January: A Terp Bros Newsletter' post

2. Scroll to the SEO plugin section at the bottom of the editor (Yoast shows 'Snippet Preview', Rankmath shows

'Meta')

3. Write a 155–160 character description that includes your main keyword (e.g., 'Discover January's top

cannabis strains, tips, and Terp Bros exclusive drops—read our latest newsletter')

4. Click 'Update' to save

5. Repeat for all other blog posts missing descriptions by checking your site with a free tool like Screaming

Frog SEO Spider (filter by 'Missing Meta Description')

4. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your site is not publishing machine-readable information about your content (like article titles, publication

dates, or author details) in a format that Google and other search engines can easily understand. This means

search engines have to guess at what your pages are about, rather than being told explicitly.

Why it matters for your business: Without schema markup, your cannabis content ranks lower in search

results, and you miss opportunities to appear in rich snippets (like review stars or article summaries) that drive

clicks and traffic.

Technical root cause: WordPress is not configured to automatically output JSON-LD schema blocks, and no

schema plugin (like Yoast SEO Premium, All in One SEO, or Schema Pro) has been installed and activated to

generate them.

Recommended fix — step by step
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1. Install the free version of Yoast SEO: WordPress Admin → Plugins → Add New → search 'Yoast SEO' → click

Install Now → Activate.

2. Go to WordPress Admin → Yoast SEO → Settings → Search Appearance → toggle 'Show date in snippet

preview' to ON.

3. Navigate to WordPress Admin → Yoast SEO → Settings → Search Appearance → Organization and fill in:

Organization name, logo URL, social profiles (Instagram, Facebook), and contact phone.

4. Edit the article page (https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/) and confirm the Yoast

SEO meta box shows 'Schema output: enabled'.

5. Use Google's Rich Results Test (https://search.google.com/test/rich-results) to validate the schema is now

present and correct.

6. Repeat for 3-5 other key pages (product pages, about page, contact page) to ensure consistent schema

coverage.

5. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your blog post about the January newsletter has 5 images that lack descriptive alt text (alternative text that

describes what's in the image). Screen readers—software that reads websites aloud for visually impaired

visitors—can't tell users what these images show. Search engines also use alt text to understand image content

and rank your site.

Why it matters for your business: Missing alt text limits your SEO visibility for image searches, reduces

accessibility for disabled customers (a legal liability under ADA), and signals poor site quality to Google,

potentially lowering your ranking for cannabis product pages.

Technical root cause: Images were inserted into the WordPress post without the alt text field being filled in

during upload. WordPress allows publishing without alt text, so it's easy to skip if not part of your editorial

workflow.

Recommended fix — step by step

1. Log into WordPress admin → Posts → 'High January: A Terp Bros Newsletter'

2. In the post editor, click each image to open the image settings panel

3. Fill in the 'Alt Text' field with a short, descriptive phrase (e.g., 'Glass bong with purple flower bud' or

'January Terp Bros product lineup on shelf')

4. Repeat for all 5 images, keeping alt text under 125 characters and descriptive but concise

5. Click 'Update' to save the post

6. Enable the Yoast SEO plugin (if not active): WordPress admin → Plugins → search 'Yoast SEO' → Activate,

then configure to flag missing alt text on all future posts

6. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)
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Business category: seo

Page URL: https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your site has no JSON-LD structured data, which is code that tells search engines what your pages are about.

Without it, Google can't easily understand whether a page is a product listing, a news article, an event, or

business information—and may rank you lower or display less useful previews in search results.

Why it matters for your business: Missing schema data reduces your visibility in local search, Google Maps

results, and rich snippets—critical for a dispensary where customers search by location and product availability.

Technical root cause: WordPress doesn't automatically add JSON-LD schema blocks. Most sites require either

a dedicated SEO plugin (like Yoast, RankMath) or custom code added to the theme's functions.php or template

files.

Recommended fix — step by step

1. Install and activate RankMath SEO (or Yoast SEO) via WordPress Admin → Plugins → Add New.

2. Go to RankMath Settings → Titles & Meta → Schema tab, and enable 'Organization' schema with your

business name, address, phone, and license number.

3. For the specific newsletter post, go to the post editor → RankMath → Schema → add 'NewsArticle' schema

type with headline, image, and publication date.

4. Install the Google Search Console plugin (RankMath integrates it) and submit your XML sitemap to verify

Google sees the schema.

5. Run your homepage and one product page through Google's Rich Results Test

(https://search.google.com/test/rich-results) to confirm schema is valid.

7. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

All 5 images on this page are missing alt text — the hidden descriptions that screen readers use to tell

blind/low-vision visitors what an image shows, and that search engines use to understand image content. This

makes the page inaccessible to assistive technology users and weakens SEO for image search.

Why it matters for your business: You're excluding customers who use screen readers, risking legal liability

under ADA compliance expectations, and losing potential traffic from Google Images and other image search

channels.

Technical root cause: Images were likely inserted into the WordPress editor without filling in the alt text field in

the media library, or the theme/plugin strips alt attributes during rendering.

Recommended fix — step by step

1. Go to WordPress Dashboard → Posts → Edit the 'Happy Terp Year' newsletter post

2. Click on the first image in the editor to select it
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3. In the right sidebar under 'Image Details,' look for the 'Alt Text' field and enter a clear, descriptive phrase

(e.g., 'Terp Bros team celebrating New Year 2024' — avoid 'image' or 'pic')

4. Repeat for all 5 images on this page

5. Click 'Update' to save the post

6. Optional: Install the plugin 'WP SEO Alt Text' to audit and bulk-add missing alt text across your entire site

8. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your site is not using JSON-LD (a structured data format that search engines read to understand page content).

Right now, Google has to guess what your pages are about based on text alone. Adding JSON-LD tells search

engines explicitly: 'This is a blog post,' 'This is a product,' or 'This is a local business.' It's like putting a label on

a box instead of making the delivery person open it and figure it out.

Why it matters for your business: Without schema markup, your dispensary's location, hours, products, and

reviews are invisible to Google—you lose local search visibility and may not show up in Maps results when

customers search for cannabis near them.

Technical root cause: WordPress sites do not auto-generate JSON-LD schema unless a plugin or theme adds

it. The Terp Bros theme/plugins are not outputting structured data blocks in the page source.

Recommended fix — step by step

1. Install the free plugin 'Yoast SEO' or 'Rank Math' (Yoast is market standard for WordPress).

2. In WordPress admin, go to Yoast SEO → Search Appearance → Company Logo and fill in business details

(name, logo, address, phone, license display).

3. For the affected post URL, go to post editor → Yoast SEO sidebar → toggle 'Schema' tab and ensure Article

schema is enabled.

4. Go to Yoast SEO → Settings → Sites Features → enable 'Local SEO' (if Yoast Premium) or use Rank Math's

free Local Business schema for dispensary address + hours.

5. For product pages (if you list inventory), add Product schema via Yoast or Rank Math so pricing and

availability appear in search results.

6. Verify output: visit the URL in Google's Rich Results Tester (search.google.com/test/rich-results) and

confirm green checkmarks for Organization and Article schemas.

9. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/
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Seven images on your newsletter page lack alt text — descriptive labels that screen readers use to tell visually

impaired visitors what an image shows. This also means search engines can't understand what those images

depict, missing opportunities to rank in Google Images and boost your page's SEO value.

Why it matters for your business: Missing alt text reduces accessibility for customers with vision impairments

(a legal compliance risk in NYC) and leaves SEO ranking potential on the table, especially for product/strain

imagery that drives organic discovery.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field in the media

library, or the theme's image blocks were not configured to require alt text on insertion.

Recommended fix — step by step

1. Log into WordPress admin → Media Library → find the 7 images used on the 'Ho Ho Bro' newsletter post

2. For each image, click it and scroll to the 'Alt Text' field; write a clear 5–10 word description (e.g., 'Green

cannabis flower strain in glass jar' or 'Terp Bros holiday newsletter header graphic')

3. Go to Posts → Ho Ho Bro newsletter post → edit and verify each image block shows alt text in the block

inspector (WordPress 5.9+) or Image Settings panel

4. Install the 'Broken Link Checker' or 'WP Image SEO' plugin to auto-flag future uploads missing alt text and

remind you to fill them in

5. Consider adding a note to your team's WordPress content checklist: 'Every image must have alt text before

publishing'

10. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post page is missing a meta description — a 150-160 character summary that appears below the page

title in Google search results. Without it, Google generates a random excerpt from your page content, which

often looks incomplete or unappealing to potential visitors.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results; a

properly written description can increase clicks by 5-10%, directly boosting traffic to your blog and brand

awareness.

Technical root cause: The WordPress post or page was published without manually adding a meta description

in the SEO plugin (if installed) or the page settings. WordPress does not auto-generate meta descriptions.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress Admin → Plugins → Add New → search

'Yoast SEO' → Install & Activate.

2. Go to WordPress Admin → Posts → Edit the 'Frozen 3 – A Terp Bros Newsletter' post.

3. Scroll to the Yoast SEO panel at the bottom of the editor and click 'Edit snippet'.

4. Write a meta description (150–160 characters) that includes your target keyword and a call to action, e.g.,

'Discover the latest terpene profiles, strain reviews, and Terp Bros updates. Read our community newsletter.'

5. Save the post and republish.

https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/


6. Repeat this step for all other blog posts and pages missing meta descriptions by running a crawl in Yoast →

Dashboard → SEO Health to identify them.

11. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your website is missing JSON-LD structured data — machine-readable code that tells Google and other search

engines what your content is about. Without it, search engines have to guess whether a page is a product,

article, event, or something else, which reduces how well your content appears in search results and featured

snippets.

Why it matters for your business: Missing schema markup hurts your visibility in Google Search results for

local cannabis dispensary queries and newsletter/content discovery, reducing organic traffic and customer

awareness of your community content.

Technical root cause: The page template or content type (in this case, a newsletter post) has no JSON-LD

schema implementation. WordPress doesn't add schema automatically; it must be added via a plugin, theme

feature, or custom code.

Recommended fix — step by step

1. Install and activate the free 'Yoast SEO' plugin (or 'Rank Math' if preferred) from WordPress admin → Plugins

→ Add New.

2. Go to the post editor for the newsletter post (Posts → All Posts → 'Frozen 3' entry).

3. In the Yoast SEO (or Rank Math) sidebar, verify the Content Type is set to 'Article' or 'NewsArticle'

(whichever matches your intent).

4. Ensure Yoast has 'Schema' enabled: admin → Yoast SEO → Settings → Site Features → turn on 'Schema

output'.

5. Re-save the post and verify schema appears in Google Search Console → URL Inspection → 'Rich Results'

tab.

6. Repeat for other newsletter and key pages (products, location pages, event announcements if any).

12. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your website should have a text description (called 'alt text') that explains what the image

shows. Right now, 5 images on your newsletter page have no description. Screen readers — tools that read web

https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/
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pages aloud for people with vision impairments — can't tell visitors what those images are. Search engines also

use alt text to understand and rank your content.

Why it matters for your business: Missing alt text reduces your SEO ranking for image searches and limits

your site's reach to customers using assistive technology, while also creating potential ADA compliance

exposure for a public-facing retail site.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

library, or the alt attribute was left blank when images were inserted into the page.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media Library → filter by 'Unattached' or search for images used on the

frozen-3-a-terp-bros-newsletter post

2. Click each image → scroll to 'Alt Text' field → write a clear, concise description (e.g., 'Terp Bros product

lineup on white background' or 'Customer reviewing cannabis flower strain')

3. If images are already inserted in the post, edit the post → click the image inline → click the pencil/edit icon

→ fill 'Alternative text' field in the popup

4. For product or strain images, include the product name and key visual detail in alt text (e.g., 'Gelato strain

bud close-up showing purple trichomes')

5. Save each change, then use WordPress's Accessibility Checker plugin (free) or WAVE browser extension to

re-scan the page and verify all images now have alt text

13. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post page is missing a meta description—the 155-character summary that appears below your page

title in Google search results. Without it, Google generates a random snippet from your page content, which

often looks unprofessional and doesn't encourage clicks. This particular post about your Terp Bros newsletter is

invisible to search engines in terms of messaging.

Why it matters for your business: Missing descriptions reduce click-through rates from search results,

meaning fewer visitors discovering your community content and newsletter signup opportunities—even if the

page ranks well.

Technical root cause: The WordPress post was published without filling in the meta description field, or the

field wasn't syndicated to the page header during publication. Most WordPress SEO plugins (Yoast, Rank Math,

All in One SEO) require manual entry per post.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → find 'The Year of the Terp' post → Edit

2. Scroll down to the SEO plugin section (Yoast, Rank Math, or similar—check which one you use in Plugins)

3. Locate the 'Meta description' field and enter: 'Discover the latest Terp Bros news, cannabis culture insights,

and community updates in our monthly newsletter.'

4. Verify the description is 150–160 characters (the plugin should show a live preview and character count)
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5. Click Update/Publish, then test the live page URL in Google Search Console Preview tool to confirm the

description displays

6. Apply the same process to all blog posts and key pages missing descriptions (check Google Search Console

→ Pages → filter by 'Missing meta description')

14. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/

Rule: tier2.schema.none

What it means (plain English)

Your blog post pages don't include JSON-LD structured data—machine-readable code that tells Google what

your content is about (e.g., article title, author, publish date). Without it, search engines have to guess the

meaning of your content, which can hurt rankings and prevent rich snippets (fancy preview boxes) from

showing up in search results.

Why it matters for your business: Missing schema reduces your visibility in Google search results for blog

content, which is critical for cannabis dispensaries building community trust and organic traffic without paid

ads.

Technical root cause: WordPress theme or page builder is not automatically injecting Article, NewsArticle, or

BlogPosting JSON-LD blocks into post templates. This is commonly missing in lightweight or customized

themes.

Recommended fix — step by step

1. Install Yoast SEO or Rank Math plugin (both free versions include schema generation).

2. Activate the plugin and navigate to its Schema settings dashboard.

3. Enable 'Article' schema type for blog posts and confirm 'Author,' 'Publish Date,' and 'Modified Date' fields

are mapped to your post meta.

4. Go to Settings > Permalinks in WordPress admin and resave to flush the cache.

5. Visit https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/ and run it through Google's

Rich Results Test (https://search.google.com/test/rich-results) to confirm JSON-LD is now present.

6. Repeat the test on 2–3 other blog posts to verify consistency.

7. Submit the updated page URL to Google Search Console (Property > URL Inspection > Request Indexing) to

re-crawl.

15. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/
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Your blog post has 7 images that lack alt text—a short text description that appears when images don't load and

helps search engines understand what the image shows. This makes the page harder for people using screen

readers (tools that read web content aloud) and costs you SEO points because Google can't index what those

images depict.

Why it matters for your business: Missing alt text reduces your search ranking for image-based queries, limits

reach to customers using accessibility tools, and can expose you to ADA compliance complaints.

Technical root cause: Images were uploaded to WordPress without filling the Alt Text field in the media

uploader, or they were embedded via HTML without alt attributes.

Recommended fix — step by step

1. Log into WordPress → go to Posts → edit 'The Year of the Terp' post

2. Click each image inline to open the image block inspector (right sidebar)

3. In the Inspector, find the Alt Text field and write a 5–10 word description (e.g., 'Terpenes under microscope'

or 'Terp Bros founder smiling')

4. For product/strain images, include the strain name and visual context (e.g., 'Purple Haze buds closeup')

5. Avoid keyword stuffing; write naturally for a person, not SEO bots

6. Click Update to save the post

7. Repeat for all 7 images, then preview the post to confirm images still display

16. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your site is not using JSON-LD (a machine-readable format that tells Google, Bing, and other search engines

what your content is about). Search engines have to guess the meaning of your pages by reading HTML alone,

which makes them less confident about your content's relevance and authority. This is especially important for

a dispensary site, where clarity about products, inventory, and compliance matters helps search engines rank

you correctly.

Why it matters for your business: Without schema markup, search engines cannot reliably understand your

product offerings, pricing, and local business details—reducing your visibility in local search results and Google

Shopping, which drives foot traffic and online orders for dispensaries.

Technical root cause: WordPress is not automatically outputting JSON-LD schema blocks. Either no SEO

plugin with schema generation is active, or it is not configured to output LocalBusiness, Product, or NewsArticle

schema for your content types.

Recommended fix — step by step

1. Install Yoast SEO or Rank Math (both free versions support schema). Go to Plugins → Add New, search

'Yoast SEO', click Install, then Activate.

2. If using Yoast: Navigate to Yoast SEO → Site Features in WordPress admin, toggle 'Schema' to ON.

3. If using Yoast: Go to Yoast SEO → Search Appearance → Content Types. Ensure 'Posts' show schema and

set Post Type to 'BlogPosting' or 'NewsArticle'.

https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/


4. For product pages (if you have them): Go to Yoast SEO → Search Appearance → Other. Add a LocalBusiness

schema block via the 'Schema' tab: set Organization type to 'LocalBusiness' (or 'CannabisStore' if

available), fill in address, phone, license number, and hours.

5. Test your homepage and product pages using Google's Rich Results Test

(https://search.google.com/test/rich-results). Paste your URL and confirm schema blocks appear.

6. Trigger a re-crawl: Go to Google Search Console → URL Inspection, paste your homepage, click 'Request

Indexing'.

17. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter page lack alt text — descriptive labels that screen readers use to tell

blind/low-vision visitors what an image shows. Search engines also use alt text to understand image content

and rank your pages. Without it, you're invisible to both audiences.

Why it matters for your business: Missing alt text reduces your SEO ranking for image searches (which drive

discovery of cannabis products), excludes disabled customers from your content, and creates legal accessibility

liability under ADA/WCAG standards.

Technical root cause: Images were uploaded to WordPress without filling the Alt Text field during media

insertion, or they were added via HTML/custom code without alt attributes.

Recommended fix — step by step

1. Log into WordPress admin → Media Library → identify images from the newsletter post (sort by date or

search 'slow melt')

2. Open each image and click Edit → scroll to Alt Text field → write 1–2 sentences describing the image (e.g.,

'Close-up of cannabis terpene crystals with golden hue')

3. If images are embedded in the post itself, go to Posts → Edit the newsletter post → click each image → click

Edit in Toolbar → add Alt Text in the sidebar

4. For any images added via HTML/code, add alt="[description]" directly to each <img> tag and test with a

screen reader (NVDA free, or macOS VoiceOver)

5. After saving, run a quick test: copy the post URL into a free accessibility checker like WAVE

(wave.webaim.org) and confirm all images now have alt labels

18. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

https://search.google.com/test/rich-results).
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This blog post page doesn't have a meta description—the 155-character summary that appears below the page

title in Google search results. Without it, Google generates a random snippet from your content, which may not

include your best selling points or call-to-action. This hurts click-through rates from search.

Why it matters for your business: Fewer clicks from Google Search means lower traffic to your community

content and fewer opportunities to build audience trust and drive newsletter signups or product discovery.

Technical root cause: The WordPress post editor did not have a meta description filled in before publishing.

Most WordPress themes and SEO plugins require manual input in the post editor or rely on plugin defaults.

Recommended fix — step by step

1. Install or verify you have Yoast SEO or Rank Math active (WordPress Plugins → Installed Plugins). If missing,

go to Plugins → Add New, search 'Yoast SEO', click Install Now, then Activate.

2. Open the affected post in WordPress editor (Posts → The Day After Terpmorrow).

3. Scroll to the Yoast SEO meta box (bottom of the editor, or a sidebar panel) and locate the 'Meta description'

field.

4. Write a 155-character description that includes your brand name, the post topic, and a benefit (e.g., 'Explore

the latest terpene trends and cannabis community news from Terp Bros NYC. Monthly insights for

connoisseurs.').

5. Click the green traffic light or 'Save' button to confirm the snippet preview looks good.

6. Click Publish or Update to save the post.

7. Repeat this process for all other blog posts and pages missing descriptions. Use WordPress admin search

(Posts → Search) to filter by posts without descriptions if your plugin supports it, or manually audit 10–20

top posts.

19. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter post have no descriptive text (called 'alt text'). This means screen readers

used by visually impaired customers can't describe those images, and search engines can't understand what

they show. Both hurt accessibility and search rankings.

Why it matters for your business: Inaccessible content can expose you to ADA compliance complaints, blocks

potential customers using assistive technology, and wastes SEO value from images that could drive traffic.

Technical root cause: Images were inserted into the WordPress post without filling the 'Alt Text' field during

upload or editing. WordPress does not auto-generate alt text.

Recommended fix — step by step

1. Log into WordPress → go to Posts → edit 'The Day After Terpmorrow' post

2. Scroll to each image in the editor; click the image to open the block settings panel on the right

3. In the 'Alt text' field, write a short 1–2 sentence description of what the image shows (e.g., 'Terp Bros team

members at NYC store opening' or 'Close-up of cannabis flower sample')

4. For product/strain images, include the strain name and key visual feature (e.g., 'Sour Diesel buds showing

frosty trichomes')

https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/


5. Click 'Update' to save the post

6. After this post, create a WordPress routine: before publishing any post with images, preview it with a screen

reader (free tool: NVDA or JAWS trial) or use the Accessibility Checker plugin (e.g., WP Accessibility or

Yoast SEO's built-in checker) to catch missing alt before launch

20. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter page have no alternative text descriptions. Alt text is read aloud by screen

readers used by people with vision disabilities, and it also helps search engines understand what your images

show. Without it, those images are invisible to both assistive technology users and search rankings.

Why it matters for your business: Missing alt text reduces accessibility for customers with disabilities (limiting

your addressable market), weakens your SEO for image search traffic, and creates potential ADA compliance

liability for a public-facing retail site.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field during upload or

in the Media Library. WordPress does not auto-generate alt text; it must be manually entered by content editors.

Recommended fix — step by step

1. Log in to WordPress admin → Media Library → search for images used in the 'blue-and-yellow-christmas-a-

terp-bros-newsletter' post

2. For each image, click Edit → scroll to Alt Text field → write a concise 5–10 word description (e.g., 'Blue and

yellow Terp Bros holiday gift box' or 'Staff holding cannabis products at holiday event')

3. Repeat for all 7 images identified in the audit

4. Go to Posts → find the newsletter post → scan the content visually to confirm all inline images now have alt

text visible in the Media details

5. In WordPress, optionally install Yoast SEO (free version) → run SEO readability check on the post to flag any

remaining missing alt text automatically for future posts

6. Create a content checklist for your editorial team: before publishing, verify all images have alt text via Media

Library or inline editor preview

21. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your site doesn't include JSON-LD structured data—machine-readable code that tells Google what your pages

are about (e.g., "this is a blog post", "this is a product", "this location has business hours"). Without it, search
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engines have to guess your content type, which reduces your visibility in rich results (special boxes with

images, ratings, or snippets that appear above regular listings).

Why it matters for your business: You're missing opportunities to appear in Google's enhanced search

results, which typically get 20–30% higher click-through rates than plain blue links—especially important for

driving foot traffic and online orders to a dispensary.

Technical root cause: WordPress doesn't add JSON-LD schema automatically unless a plugin or custom code

is installed. Most WordPress SEO plugins (Yoast, Rank Math, All in One SEO) include schema generation, but the

site either lacks one or it's not configured to emit schema blocks.

Recommended fix — step by step

1. Install Yoast SEO (free) from WordPress Plugins → Add New, search 'Yoast SEO', install + activate.

2. Go to Yoast SEO → Integrations in the WordPress admin, and connect your Google Search Console account

(if not already done).

3. Visit Yoast SEO → Schema, review the toggles for 'Organization', 'WebPage', and 'Article' schema—ensure all

are enabled.

4. Edit the blog post at /its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/ and check Yoast's

'Schema' tab at the bottom—confirm 'Article' schema is assigned and your author/published date are set.

5. If you sell products on-site, ensure Yoast SEO → Schema → 'Products' is enabled so product pages emit

Product + AggregateOffer schema.

6. Test a published post at Google's Rich Results Test (search.google.com/test/rich-results)—paste the URL

and confirm Article schema appears.

7. Consider adding Local Business schema for your physical location: Yoast SEO → Search Appearance →

Organization → fill in address, phone, hours—this is high-value for dispensaries.

22. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/black-friday-at-terp-bros/

Rule: tier2.schema.none

What it means (plain English)

Your site isn't using JSON-LD structured data — a standardized format that tells search engines what your

pages are about in a machine-readable way. Think of it like labeling your storefront clearly so Google can

understand and display key details (like your address, hours, or product info) in search results and on Google

Maps.

Why it matters for your business: Without schema markup, you're missing opportunities to appear in rich

search results (like business knowledge panels, event listings, or product cards), which reduces click-through

rates from search and makes your dispensary harder to find online.

Technical root cause: WordPress doesn't automatically generate JSON-LD schema blocks for pages. You

either need a plugin to create and insert this structured data, or manually add it to your theme's template files.

Recommended fix — step by step

1. Install Yoast SEO or Rank Math (both free versions support schema) via WordPress Dashboard > Plugins >

Add New > search 'Yoast SEO' > Install & Activate.

https://terpbrosnyc.com/black-friday-at-terp-bros/


2. Go to the plugin settings (Yoast: Dashboard > Yoast SEO > Settings; Rank Math: Dashboard > Rank Math >

Settings) and enable schema types for your business type (LocalBusiness or CannabisRetailStore if

supported).

3. Visit the affected blog post (Black Friday page) and edit it; the plugin will auto-add schema options in the

meta box below the editor — fill in canonical URL, breadcrumbs, and any product/event details.

4. For your dispensary's main pages (home, about, contact), use the plugin's Schema tab to mark your

business location, hours, phone, and license info.

5. Test your schema output using Google's Rich Results Test (https://search.google.com/test/rich-results) —

paste your URL and verify schema appears without errors.

6. Submit the updated pages to Google Search Console (Property > URLs > Request Indexing) so Google re-

crawls and indexes the new schema.

23. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/black-friday-at-terp-bros/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your Black Friday page don't have alt text—short descriptions that tell screen readers and

search engines what each image shows. This means visually impaired customers can't understand those

images, and Google can't index them for image search. It's a quick fix that opens your content to more people

and improves search visibility.

Why it matters for your business: Missing alt text blocks visually impaired customers from understanding your

Black Friday promotion, reduces image search traffic, and creates legal accessibility risk under ADA/AAPA

standards—important for any retail site but especially in regulated cannabis.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field during upload or

in the image block settings. WordPress doesn't auto-generate alt text, so blank alt attributes remain.

Recommended fix — step by step

1. Go to WordPress Admin → Media Library and filter to show images from the Black Friday post.

2. Click each image and scroll to the 'Alt Text' field in the sidebar; write a 5–10 word description (e.g., 'Black

Friday discount offer on premium cannabis flower' or 'Holiday sale banner with Terp Bros logo').

3. Save each image update.

4. Alternatively, edit the post directly: go to Posts → Black Friday post → click each image in the editor → click

the pencil icon → fill 'Alt Text' field → click Update.

5. Audit other pages using a free tool like axe DevTools browser extension (axe.deque.com) to flag remaining

missing alt text site-wide.

6. Create a WordPress checklist template for content editors: before publishing, run a quick alt-text check

using the built-in image block inspector.

24. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://search.google.com/test/rich-results)
https://terpbrosnyc.com/black-friday-at-terp-bros/


Business category: seo

Page URL: https://terpbrosnyc.com/green-wednesday-at-terp-bros/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about Green Wednesday doesn't have a meta description — the short summary (usually 155–160

characters) that appears under your link in Google search results. Without it, Google generates a random

snippet from your page, which often looks unprofessional and misses your chance to tell customers why they

should click.

Why it matters for your business: A missing meta description loses click-through rate from search results;

potential customers see a confusing excerpt instead of a compelling offer, reducing store traffic and foot traffic

from online discovery.

Technical root cause: The page was published without manually entering a meta description in WordPress, and

no site-wide default or SEO plugin is auto-generating one for blog posts.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'Green Wednesday at Terp Bros' → scroll to the Yoast SEO or

Rank Math plugin panel (if installed) and enter a meta description under 160 characters (e.g., 'Join us for

Green Wednesday savings on premium flower, concentrates & edibles. Limited-time deal for NYC members.')

2. If no SEO plugin is active, install Yoast SEO (free version): Plugins → Add New → search 'Yoast SEO' →

Install & Activate, then repeat step 1.

3. After adding the description, click Update/Publish on the post.

4. Audit your other blog posts for missing descriptions using Yoast's Site Audit tool (Yoast SEO → Site Health)

and add descriptions to any flagged posts.

5. Set a site default: Yoast SEO → Search appearance → disable 'Include date' if not needed for blog posts, and

set a fallback description template so future posts auto-generate one if the author forgets.

25. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/green-wednesday-at-terp-bros/

Rule: tier2.schema.none

What it means (plain English)

Your site is not using JSON-LD (a standardized way to tell search engines what your content is about in

machine-readable format). This means Google has to guess whether a page is a product listing, a blog post, an

event, or something else—and it often guesses wrong. For a cannabis retailer, this is especially risky because

search engines need to understand your license status, inventory, and compliance info to rank you correctly.

Why it matters for your business: Without schema markup, Google cannot confidently display your products,

events (like Green Wednesday promotions), or business information in search results, reducing click-through

rates and making it harder for customers to find you in local search.

Technical root cause: WordPress sites do not automatically generate JSON-LD schema. Most plugins that add

schema (like Yoast SEO or RankMath) are either not installed, or are installed but not configured to output

blocks for this content type (e.g., custom post types, event pages).

Recommended fix — step by step

https://terpbrosnyc.com/green-wednesday-at-terp-bros/
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1. Install Yoast SEO (free version) via WordPress Admin → Plugins → Add New → search 'Yoast SEO' → Install &

Activate

2. Go to Yoast SEO → Site Connections → link your Google Search Console and Google Business Profile

3. Navigate to Yoast SEO → Search Appearance → Content Types, and enable schema for Posts and Pages

4. For the Green Wednesday page specifically, edit the post → scroll to Yoast SEO metabox → click 'Schema'

tab → select 'Event' from the schema type dropdown and fill in date/time

5. For product/inventory pages (if any), use Yoast's Product schema option or install WooCommerce and use

its built-in schema output

6. Test the page at https://schema.org/validator or Google's Rich Results Test (search.google.com/test/rich-

results) to confirm JSON-LD is now present

26. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your website doesn't include JSON-LD structured data — machine-readable code that tells search engines what

your pages are about. Without it, Google can't easily understand your content, product listings, or business

information, which hurts your visibility in search results and knowledge panels.

Why it matters for your business: Missing structured data reduces your chances of appearing in local search

results, product carousels, and Google Maps — all critical for driving foot traffic and online orders to a cannabis

retail location.

Technical root cause: WordPress installations typically don't include JSON-LD schemas by default. The site

likely lacks an SEO plugin (like Yoast, RankMath, or All in One SEO) configured to auto-generate schemas, or

schemas were never manually added to key pages.

Recommended fix — step by step

1. Install and activate a WordPress SEO plugin: install Yoast SEO, RankMath, or All in One SEO Pro from the

Plugins > Add New admin panel.

2. In the plugin settings, enable 'Local Business' schema type and fill in your business name, address, phone,

hours, and license number (if applicable).

3. On the affected newsletter thank-you page (/thanks-for-giving-a-terp-bros-newsletter/), ensure the plugin's

schema settings are applied — check the plugin's page-level options or use a custom schema block if

available.

4. Generate schemas for your product pages (if selling online): use the plugin's product schema feature or

enable WooCommerce/product schema auto-generation.

5. Test the result using Google's Rich Results Test (search.google.com/test/rich-results) — paste your

homepage URL and verify schemas appear correctly.

6. Submit the updated pages to Google Search Console (console.google.com) via the URL Inspection tool to

re-crawl and index the new schema markup.

27. 7 image(s) missing alt text

https://schema.org/validator
https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/


Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter thank-you page don't have alt text—descriptive labels that explain what each

image shows. Search engines can't read images, so without alt text, those images are invisible to Google and to

visitors using screen readers (assistive software for visually impaired users). This means you're missing SEO

value and excluding potential customers.

Why it matters for your business: Missing alt text reduces your page's relevance in Google search results and

makes your site inaccessible to blind or low-vision customers, which is both a legal risk under ADA compliance

and a lost sales opportunity.

Technical root cause: Images were uploaded to WordPress without filling in the alt text field during upload or

edit. WordPress stores alt text in the image metadata, and if that field is left blank, the images render without

accessibility or SEO information.

Recommended fix — step by step

1. Log in to WordPress admin → Media Library → filter by images used on /thanks-for-giving-a-terp-bros-

newsletter/

2. Click Edit on each of the 7 images

3. In the right sidebar under 'Alt Text', write a clear, factual description (e.g., 'Terp Bros branded newsletter

signup confirmation graphic' or 'cannabis leaf pattern decorative element')

4. Click Update and repeat for all 7 images

5. Run a quick audit in WordPress: install free plugin 'WP Accessibility' → Tools → Accessibility Report to

confirm all images now have alt text

6. Optional: use Yoast SEO (if installed) → go to the newsletter page → Readability tab will confirm alt text is

present

28. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/

Rule: tier2.meta.no-description

What it means (plain English)

Your page about the Ozone Park newsletter is missing a meta description — a 155-character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a snippet that

doesn't represent your content well, reducing click-through rates from search.

Why it matters for your business: Missing meta descriptions lower click-through rates from Google Search,

directly reducing foot traffic and customer acquisition for your dispensary locations.

Technical root cause: The WordPress page or post was created without a meta description field filled in, either

because no SEO plugin is configured or the field was left blank during content creation.

https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/
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Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Admin → Plugins → Add New, search 'Yoast SEO', click Install

& Activate.

2. Go to WordPress Admin → Posts, find and edit 'Terp Bros Ozone Park Newsletter 1'.

3. Scroll to the Yoast SEO panel at the bottom of the page; click the 'Snippet Editor' tab.

4. In the 'Meta description' field, write a compelling 155-character summary, e.g.: 'Join Terp Bros Ozone Park's

exclusive newsletter for strain drops, member deals, and NYC cannabis community updates.'

5. Click 'Save' or 'Update Post'.

6. Repeat this process for all other pages flagged in your audit; prioritize high-traffic pages first.

29. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/

Rule: tier2.schema.none

What it means (plain English)

Your website isn't marking up its content with structured data — a machine-readable label that tells Google

what your pages are about. For a dispensary, this means Google can't automatically recognize your location,

hours, products, or reviews, which reduces your visibility in local search results and knowledge panels.

Why it matters for your business: Without schema markup, you're missing opportunities in Google Local Pack

listings, which drive foot traffic; customers searching 'cannabis dispensary near me' won't see your store

information, hours, or star ratings as prominently as competitors who use schema.

Technical root cause: The page template lacks JSON-LD blocks in the <head> or body. WordPress doesn't

auto-generate schema for custom post types (like newsletter posts) unless you explicitly add it via a plugin or

theme code.

Recommended fix — step by step

1. Install Yoast SEO plugin (free version) → Activate → Go to Settings → Integrate with Google Search Console

and Google Business Profile

2. For your homepage, product pages, and location pages: Yoast will auto-generate LocalBusiness +

OpeningHoursSpecification schema; verify it in Yoast's Schema settings → toggle 'Organization' + 'Local

Business' ON

3. For custom post types (newsletters, blog): Use Yoast's 'Schema' sidebar in the post editor → select 'Article'

schema type → fill in headline, featured image, publish date

4. Test your homepage at https://schema.org/validator/ → paste URL → confirm you see LocalBusiness,

Organization, and OpeningHours blocks in the output

5. Add your dispensary's license number and owner info to the schema: in Yoast Settings → Business Profile →

'Organization' section, ensure name, address, phone, hours, and license number are complete

30. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/
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Business category: accessibility

Page URL: https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter page don't have alt text — descriptive labels that tell search engines and

screen readers (software that reads pages aloud for visually impaired users) what each image shows. This

means customers using assistive technology can't understand those images, and Google can't index them for

image search or context.

Why it matters for your business: Missing alt text reduces your SEO visibility for product and menu images,

blocks visually impaired customers from your site (potential legal liability under ADA), and wastes an

opportunity to rank for image search traffic that drives cannabis dispensary discovery.

Technical root cause: Images were likely inserted into the WordPress editor without filling in the 'Alt Text' field

during upload, or were added via HTML without an alt attribute.

Recommended fix — step by step

1. Log into WordPress admin → go to Media Library → filter by images used on the newsletter post

(https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/)

2. Open each image's details panel and add descriptive alt text (e.g., 'Terp Bros OG Kush flower eighth' instead

of 'image123.jpg'). Be specific: include strain name, product type, and visual detail if relevant.

3. Alternatively, edit the post directly: go to Posts → Edit the newsletter → switch to 'HTML' editor (if available)

and add alt='' attributes to all <img> tags

4. Use Yoast SEO plugin (likely already installed): it will flag missing alt text in the editor and suggest fixes

5. Once fixed, do a spot-check: right-click each image in your browser → Inspect → confirm <img> tag has

alt="[description]" attribute

31. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your website doesn't include JSON-LD structured data—a machine-readable format that tells Google and other

search engines what your pages are about. For a cannabis retail site, this means search engines can't reliably

understand your product listings, location, business hours, or age-restricted status, which limits your visibility

in local search results and product carousels.

Why it matters for your business: Without structured data, you're losing local search visibility ("cannabis near

me"), making it harder for customers to find your dispensary, verify your hours, or see product details in Google

Search results.

Technical root cause: The WordPress site has no JSON-LD schema.org markup installed or manually added to

pages. WordPress doesn't output this data by default; it requires either a dedicated SEO plugin (Yoast, Rank

Math, etc.) configured with schema settings, or hand-coded blocks.

Recommended fix — step by step

https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/
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1. Install Yoast SEO or Rank Math plugin from WordPress.org → Plugins → Add New (search "Yoast SEO" or

"Rank Math")

2. Activate the plugin and go to the plugin settings → Schema tab, enable LocalBusiness schema and set your

dispensary name, address, phone, hours

3. For the newsletter page specifically: edit the post → scroll to the Yoast/Rank Math box at bottom → Schema

section → select "WebPage" as schema type

4. Add breadcrumb schema: Settings → [SEO Plugin] → Breadcrumbs → toggle ON

5. Test using Google's Rich Results Test (search.google.com/test/rich-results) — paste your homepage URL

and verify schema appears

6. If you prefer manual schema: edit page templates → add a code block with LocalBusiness JSON-LD (name,

address, phone, license info) in the <head> — requires developer access or child theme editing

32. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter page don't have alt text—descriptive labels that screen readers read aloud to

visually impaired visitors and that search engines use to understand image content. This means customers

using assistive technology can't see what those images show, and Google can't index them properly.

Why it matters for your business: Missing alt text reduces your SEO ranking for image searches, blocks

accessibility (potentially exposing you to legal liability under ADA), and degrades user experience for a portion

of your audience.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field during media

upload or editing. WordPress doesn't auto-generate alt text; it must be added manually in the Media Library or

post editor.

Recommended fix — step by step

1. Log in to WordPress admin and navigate to Media Library.

2. Search for or locate the images used on the 'run-for-it-a-terp-bros-newsletter' post (or use the post editor

→ click each image).

3. For each image, click it and fill the 'Alt Text' field with a concise, descriptive phrase (e.g., 'Terp Bros team at

community event' or 'Cannabis flower strain close-up')—avoid keyword stuffing; describe what's actually

shown.

4. Repeat for all 7 images, then save/update the post.

5. Optional but recommended: Install Yoast SEO plugin (free version) → run the post through its analyzer to

flag any remaining missing alt text site-wide.

6. Do a quick audit of other high-traffic pages (home, product pages, about) for missing alt text using the same

process.

33. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/


Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your Muchie Madness article have no alternative text descriptions. Alt text is read aloud by

screen readers (tools blind customers use to browse the web) and helps search engines understand what

images show. Without it, you're invisible to both audiences.

Why it matters for your business: You lose SEO credit for image search traffic, and you exclude visually

impaired customers — both reduce discoverability and violate accessibility law (ADA), creating legal risk.

Technical root cause: Images were likely inserted into the WordPress post without filling in the Alt Text field in

the image block or media library. WordPress allows uploading images without this required field.

Recommended fix — step by step

1. Log into WordPress admin → Posts → edit 'Muchie Madness' article

2. For each image, click it to open the image block toolbar → click the image thumbnail or 'Edit' button

3. In the right-side Image settings panel, find 'Alt text (alternative text)' field and write a 5–10 word description

of what the image shows (e.g., 'Colorful cannabis flower buds close-up')

4. Repeat for all 7 images, then click Publish/Update

5. Install free plugin 'WP Accessibility' (Plugins → Add New → search 'WP Accessibility' → Install & Activate) to

flag future missing alt text before publish

6. Go to WP Accessibility settings (Settings → WP Accessibility) and enable 'Check for missing alt attributes'

34. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your newsletter post have no alt text—descriptive text that explains what each image shows.

Search engines and screen readers (used by people with vision loss) can't understand these images. This

means you're losing SEO value and excluding customers who rely on accessibility tools.

Why it matters for your business: Missing alt text reduces your search ranking for image-related queries,

lowers the page's overall SEO score, and makes your site inaccessible to a portion of your audience—both

hurting discoverability and brand inclusivity.

Technical root cause: Images were likely added to the post without the alt text field being filled in during

upload or editing. WordPress requires manual entry of alt text for each image; it doesn't auto-generate it.

Recommended fix — step by step

1. Log into WordPress admin → navigate to Posts → edit the post 'Tacos, Time Capsules & a Terp Bros

Newsletter'

2. In the editor, click on the first image to select it

https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/
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3. In the right sidebar panel, scroll to 'Image Details' or 'Alt Text' field

4. Write a concise, descriptive alt text (e.g., 'Freshly rolled cannabis joint on wooden surface' or 'Terp Bros

team sampling flower'); aim for 5–15 words

5. Repeat for all 7 images in the post

6. Click Update to save changes

7. Optional: Install the free plugin 'WP Accessibility' to get alt text reminders before publishing future posts

35. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your website doesn't include JSON-LD structured data—a machine-readable format that tells Google what your

pages are about (e.g., 'this is a blog post about a product' or 'this is a dispensary location'). Without it, search

engines have to guess your content type, which can hurt how your pages appear in search results and rich

snippets.

Why it matters for your business: Missing schema markup means Google may not display your content in rich

results (like star ratings, article dates, or location info), reducing click-through rates from search and making it

harder for customers to find you vs. competitors with proper schema.

Technical root cause: WordPress sites ship without JSON-LD by default. The site is either not using an SEO

plugin that auto-generates schema (like Yoast or RankMath), or the plugin is installed but schema output is

disabled in settings.

Recommended fix — step by step

1. Install the free Yoast SEO plugin: Dashboard → Plugins → Add New → search 'Yoast SEO' → Install and

Activate.

2. Go to Yoast SEO → Settings → Integrations and verify 'Zapier' and schema toggles are enabled.

3. Navigate to Yoast SEO → Search Appearance → Content Types. Enable schema for 'Posts' and 'Pages'.

4. In Yoast SEO → Search Appearance → Company, fill in your business name, logo, address, phone, and social

profiles. This generates Organization schema for all pages.

5. For the affected blog post (Hotel Terpsylvania), edit it and ensure the Yoast SEO metabox has 'Article'

selected in the Content Type dropdown.

6. Save and check one live page in Google's Rich Results Test (search.google.com/test/rich-results) to confirm

schema is now present.

36. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/

Rule: tier2.meta.no-description

https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/
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What it means (plain English)

This blog post page is missing a meta description — the 155-character summary that appears below your page

title in Google search results. Without it, Google generates a random excerpt from your page content, which

often looks unprofessional and doesn't tell potential visitors what the post is about.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

people won't know why they should visit this event post, so they'll click a competitor's result instead.

Technical root cause: WordPress blog posts don't automatically generate meta descriptions. The post was

published without filling in the SEO plugin's meta description field (or the site isn't using an SEO plugin that

enforces it).

Recommended fix — step by step

1. Install Yoast SEO plugin if not already active: WordPress Admin → Plugins → Add New → search 'Yoast SEO'

→ Install and Activate

2. Navigate to WordPress Admin → Posts → Edit the 'Miles for MBC' post

3. Scroll to the Yoast SEO meta box (below the editor); click 'Edit snippet'

4. In the 'Meta description' field, write 155 characters max describing this event (e.g., 'Join Terp Bros for the

5th Annual Miles for MBC benefit event. Support Kelly Marie and MBC with us in NYC.')

5. Repeat this for all other blog posts missing descriptions (prioritize recent/high-traffic posts first)

37. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/

Rule: tier2.schema.none

What it means (plain English)

Your event page doesn't include JSON-LD structured data — machine-readable code that tells Google what the

page is about (in this case, an event). Without it, search engines have to guess, which means they may not

display your event in Google's event listings, calendar integrations, or rich search results that show dates,

locations, and ticket info.

Why it matters for your business: Missing schema markup reduces visibility in Google Search and Google

Maps event results, directly limiting discoverability for community events and potentially suppressing ticket or

attendance sign-ups.

Technical root cause: The WordPress theme or plugins in use are not automatically generating Event

schema.org JSON-LD blocks for event post types, or the blocks were never manually added to this specific

event post.

Recommended fix — step by step

1. Install the free 'Yoast SEO' plugin (if not already active): wp-admin → Plugins → Add New → search 'Yoast

SEO' → Install & Activate.

2. Go to wp-admin → Yoast SEO → Settings → Search appearance → Content types, and ensure 'Posts' (or

your event custom post type) is set to 'Show in search results.'

3. Edit the affected event post (wp-admin → Posts → 'Miles for MBC' → Edit).
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4. Scroll to the 'Yoast SEO' metabox at the bottom; click 'Schema' tab and confirm 'Article' or 'Event' schema

is selected. If 'Event' is not an option, install 'Yoast SEO Premium' or use the free alternative 'All in One

Schema Rich Snippets' plugin.

5. Fill in event details in Yoast's schema section: event title, date, time, location (venue name & address), and

ticket/registration URL if applicable.

6. Publish/update the post and test using Google's Rich Results Test (search.google.com/test/rich-results) to

confirm Event schema appears in the JSON-LD block.

38. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

All 7 images on this event page lack alt text—short descriptions that screen readers read aloud to blind/low-

vision visitors, and that search engines use to understand image content. Without alt text, those visitors can't

understand what the images show, and Google can't index them for image search.

Why it matters for your business: You're losing accessibility compliance (required under ADA for public-facing

sites), excluding customers with disabilities, and missing image search traffic that could drive discovery to your

community events.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field in the media

editor, or the theme/page builder didn't prompt for it during image insertion.

Recommended fix — step by step

1. Log into WordPress admin → go to Media Library → filter by images used on that event page URL

2. Click each image and open its details panel (click the image thumbnail in the library)

3. In the 'Alt Text' field, write 1–8 words describing what the image shows (e.g., 'Terp Bros team at Miles for

MBC charity run' or 'Kelly Marie holding fundraising check')

4. Click 'Update' after each alt text entry

5. Alternatively, edit the page directly: click the image block → click the image icon in the toolbar → paste alt

text into the 'Alt Text' field and save

6. Test: use a free tool like WAVE (wave.webaim.org) or axe DevTools (browser extension) to confirm all 7

images now have alt text

39. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/
https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/


Every image on your website should have alt text — a short text description that screen readers read aloud to

visually impaired visitors, and that search engines use to understand what the image shows. On this blog post,

all 7 images are missing these descriptions. This locks out both customers with vision disabilities and search

engines trying to index your content.

Why it matters for your business: Missing alt text reduces your SEO ranking for image search (customers

searching for cannabis products, strains, or events on Google Images won't find you), and excludes disabled

customers who rely on screen readers — both lost revenue and compliance risk.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field during upload or

in the Media Library. WordPress allows alt text to be skipped, so it defaults to empty.

Recommended fix — step by step

1. Log into WordPress admin → Media Library, find each of the 7 images from that blog post

2. Click each image → click 'Edit' → scroll to 'Alt Text' field → write a brief, factual description (e.g., 'Bavarian

pretzel with mustard on wooden board' or 'Terp Bros team at community block party event')

3. Save each one → return to the blog post and confirm it reloads

4. Install the free plugin 'WP Accessibility' → Settings → check 'Warn if image has no alt text' to prevent this in

future uploads

5. Alternatively, install 'SEO by Yoast' (if not already active) → go to that post's Yoast metabox → it will flag

missing alt text on future edits as a reminder

40. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page is missing a meta description — the 150–160 character summary that appears below your

page title in Google search results. Without it, Google will auto-generate a snippet from your page content,

which often looks choppy or incomplete. This directly affects click-through rates from search.

Why it matters for your business: Users searching for cannabis content see a poorly formatted or irrelevant

preview of your page in Google, reducing clicks and traffic to your newsletter signup or product pages.

Technical root cause: The WordPress post editor did not have a meta description field filled in during

publication. By default, WordPress does not add a meta description unless a plugin (like Yoast SEO or Rank

Math) is active and configured, or the description is manually added to the post.

Recommended fix — step by step

1. Install the free Yoast SEO plugin: WordPress admin → Plugins → Add New → search 'Yoast SEO' → Install

Now → Activate

2. Edit the affected post: WordPress admin → Posts → 'Fried Chicken Bliss' → scroll to the Yoast SEO box at

the bottom

3. In the Yoast SEO box, click the Meta description field and write a 150–160 character summary (e.g., 'Explore

Terp Bros' latest cannabis insights and community updates. Join our newsletter for exclusive tips.')

4. Ensure the traffic light icon turns green, indicating the description is the right length

5. Click Update to save the post

https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/


6. Repeat this process for all other published posts missing meta descriptions (use WordPress → Posts and

check each one)

41. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your site doesn't include JSON-LD structured data — machine-readable code that tells Google what type of

content lives on each page (a product, article, local business, etc.). Without it, search engines have to guess

your content's meaning, which limits how your pages appear in search results and special features like rich

snippets.

Why it matters for your business: Missing schema reduces your visibility in Google search results, lowers

click-through rates from SERPs, and prevents eligibility for rich snippets (star ratings, pricing, availability) that

drive traffic and trust for cannabis retailers.

Technical root cause: The WordPress theme and/or installed SEO plugins are not generating or outputting

JSON-LD blocks for articles, product pages, or local business information. This is often because either the

theme lacks schema support or plugins like Yoast/Rank Math are disabled, misconfigured, or not deployed on

this specific URL.

Recommended fix — step by step

1. Install and activate Yoast SEO (if not already active): go to Plugins → Add New → search 'Yoast SEO' →

Install Now → Activate.

2. Navigate to Yoast SEO → Settings → XML Sitemaps → toggle 'XML sitemaps' ON to ensure schema indexing

is enabled.

3. Go to Yoast SEO → Settings → Search Appearance → toggle 'Show date in snippet preview' and 'Show

author in snippet preview' ON for articles.

4. Edit the affected newsletter post: go to Posts → All Posts → find 'Fried Chicken Bliss' → click Edit → scroll to

the Yoast SEO meta box at the bottom → confirm 'Post type' is set to 'Article' (not 'Uncategorized').

5. In that same post editor, under Yoast's 'Schema' tab, ensure the schema type is 'Article' and all fields

(headline, description, publication date) are populated.

6. Save the post and run it through Google's Rich Results Test (https://search.google.com/test/rich-results) to

verify JSON-LD is now present and valid.

7. Repeat steps 4–6 for all high-traffic pages (product pages, blog posts, dispensary info pages).

42. 8 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/

Rule: tier2.a11y.img-missing-alt

https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/
https://search.google.com/test/rich-results)
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What it means (plain English)

Every image on your website needs descriptive text (called 'alt text') that explains what the image shows.

Search engines and screen readers used by people with visual impairments rely on this text. Right now, all 8

images on your Forest Hills Kiwanis event page are missing these descriptions, which means they're invisible to

both Google and accessibility tools.

Why it matters for your business: Missing alt text reduces your search visibility for image-based queries,

limits your reach to customers using assistive technology, and signals poor site quality to search engines—all

factors that suppress organic traffic and customer acquisition.

Technical root cause: Images were likely uploaded to WordPress without filling in the 'Alt Text' field during

insertion. WordPress doesn't auto-generate alt text; it must be manually entered for each image.

Recommended fix — step by step

1. Log into WordPress Admin → navigate to the Forest Hills Kiwanis event post (Posts → All Posts → search/find

the post)

2. Click 'Edit' on that post; scroll to each image block in the editor

3. Click on each image → in the right sidebar under 'Image Settings', locate the 'Alt Text' field

4. Write 1–2 sentence descriptions for each image (e.g., 'Terp Bros team members networking at Forest Hills

Kiwanis event, October 2024' or 'Cannabis product display at community business mixer')

5. Ensure descriptions are factual and relevant—mention the event, date, or product category where applicable

6. Click 'Update' to save the post

7. Install the free plugin 'WP Image Alt Text' (Plugins → Add New → search 'WP Image Alt Text') for automated

checks on future uploads; configure it to flag missing alt text on publish

43. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This page about your newsletter doesn't have a meta description — the 150-160 character summary that

appears below the page title in Google search results. Without it, Google generates a random excerpt from your

page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

directly lowering traffic to your newsletter signup and community content.

Technical root cause: The WordPress post or page editor either wasn't filled in with a description, or your SEO

plugin (if installed) isn't configured to auto-generate fallbacks from the post excerpt.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'Season of the Terp' post

2. If using Yoast SEO: scroll to the 'Yoast SEO' meta box at bottom → click 'Edit snippet' → fill the 'Meta

description' field with a 155-character summary (e.g., 'Join Terp Bros newsletter for exclusive cannabis

education, strain reviews, and community events in NYC.')

3. If using Rank Math: look for 'Rank Math' panel on the right → expand 'General' → fill 'Meta Description'

https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/


4. If no SEO plugin is active: install Yoast SEO (free version) from Plugins → Add New, activate it, then repeat

step 2

5. Click 'Update' or 'Publish' to save

6. Repeat for any other newsletter/community pages missing descriptions

44. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your website is missing JSON-LD structured data—machine-readable labels that tell Google what your content

is about. Right now, search engines have to guess. For a cannabis community site, this means Google can't

reliably understand your blog posts, your brand, or your location, which hurts your visibility in search results.

Why it matters for your business: Without schema markup, your blog content and brand appear generic to

search engines; you lose local visibility in NYC dispensary and cannabis community searches, and you won't

appear in rich snippets (special formatted results that drive clicks).

Technical root cause: The WordPress site has no JSON-LD schema blocks installed or configured. Most

WordPress sites rely on plugins (like Yoast SEO, Rank Math, or Schema Pro) to auto-generate this markup; none

appear to be active here.

Recommended fix — step by step

1. Install and activate the Yoast SEO plugin (wordpress.org/plugins/wordpress-seo) via WordPress Admin >

Plugins > Add New.

2. Go to Yoast SEO > Settings > Site Connections and connect your Google Search Console account.

3. Go to Yoast SEO > Settings > Organization and fill in: Business name (Terp Bros NYC), logo URL, address,

phone, social profiles.

4. Edit the blog post at /season-of-the-terp-a-terp-bros-newsletter/ and set the Yoast SEO block: Article type

= 'News article' or 'Blog post', Primary category = community/news.

5. Go to Yoast SEO > Crawl optimization and enable breadcrumb schema.

6. Save and re-check the page at schema.org/validator (paste URL) to confirm schema is now present.

7. Repeat step 4 for all high-traffic blog posts and category pages over the next 2 weeks.

45. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/
https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/


Seven images on your newsletter page lack descriptive alt text — the hidden text that describes what an image

shows. This means screen reader users (people who are blind or have low vision) hear nothing when they

encounter those images, and search engines can't understand what those images depict. Both hurt your reach.

Why it matters for your business: Missing alt text reduces your ability to rank for image-based searches and

blocks customers using accessibility tools from understanding your content, shrinking your addressable

audience.

Technical root cause: Images were uploaded or inserted into the WordPress post without filling in the 'Alt Text'

field during upload or via the block editor.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → 'Season of the Terp' post

2. In the block editor, click each image block

3. In the right sidebar under 'Image Settings', locate the 'Alt Text' field

4. Write a short, descriptive alt text for each image (e.g., 'Terp Bros dispensary storefront' or 'Cannabis

terpene profile chart')

5. For product/strain images, include the strain or product name; for lifestyle shots, describe what's shown

6. Avoid keyword stuffing — keep alt text conversational and under 125 characters

7. Click 'Update' to save the post

46. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

Your newsletter page (/frozen-fire-a-terp-bros-newsletter/) is missing a meta description — a 150-160

character summary that appears below your page title in Google search results. Without one, Google will auto-

generate a snippet from your page content, which may not highlight what makes this page valuable to potential

visitors.

Why it matters for your business: A missing meta description reduces click-through rates from search results,

meaning fewer newsletter signups and lower organic traffic to this engagement page.

Technical root cause: The WordPress page or post was created without filling in the SEO meta description

field, or the theme/SEO plugin is not outputting a description tag in the page header.

Recommended fix — step by step

1. Log into WordPress admin → Pages or Posts → find 'Frozen Fire – A Terp Bros Newsletter'

2. If using Yoast SEO, scroll to the Yoast SEO box at the bottom of the editor and fill in the 'SEO Title' and

'Meta description' fields with a unique 150-160 character summary (e.g., 'Stay updated with Terp Bros'

latest cannabis tips, strain reviews, and NYC dispensary news.')

3. If not using Yoast, check your theme settings or install Yoast SEO (free version) → enable it for posts/pages

4. Click Update/Publish and wait 5 minutes for WordPress to regenerate the page

5. Visit the live page in an incognito browser, right-click → View Page Source, and search for 'meta

name="description"' to confirm the tag now exists

https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/


6. Add this same newsletter page URL to Google Search Console → Request Indexing to force a faster refresh

of the search result snippet

47. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page doesn't have a meta description — a 150-160 character summary that appears in Google

search results. Without it, Google generates a snippet automatically, which often cuts off awkwardly or

misrepresents your content. For a cannabis community site, this is a missed opportunity to control how your

content appears in search.

Why it matters for your business: Potential clicks are lost because search results look incomplete or

unprofessional, and users can't tell if the post is relevant before clicking. This directly reduces organic traffic to

your newsletter content.

Technical root cause: WordPress is not automatically generating or requiring meta descriptions for blog posts.

Either the theme doesn't include a built-in meta description field, or the field is left empty during publication.

Recommended fix — step by step

1. Install the free Yoast SEO plugin (if not already active) via WordPress Admin → Plugins → Add New, search

'Yoast SEO', then activate it.

2. Edit the affected post (WordPress Admin → Posts → Happy Terp Year) and scroll to the Yoast SEO panel at

the bottom of the editor.

3. Click in the 'Meta description' field and write a 150-160 character summary, e.g.: 'Year-end cannabis news,

terp trends, and updates from Terp Bros NYC community. Read our latest newsletter.'

4. Check the green light icon in Yoast to confirm the description length is optimal.

5. Click Update to save the post.

6. Repeat this process for other blog posts missing descriptions by auditing WordPress Admin → Posts and

filtering by Yoast SEO readability/optimization status.

48. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This page is missing a meta description — the 150-160 character snippet that appears below the page title in

Google search results. Without it, Google generates a random excerpt from your content, which may not

highlight your best selling points or relevant information.

https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/
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Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see generic or irrelevant previews instead of a compelling reason to visit your newsletter

signup or content.

Technical root cause: The WordPress post or page does not have a meta description field filled in, or the SEO

plugin (Yoast, Rank Math, etc.) is not configured to auto-generate descriptions for this content type.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'Ho Ho Bro – a Terp Bros Newsletter' post

2. Scroll to the SEO plugin metabox (Yoast SEO, Rank Math, or All in One SEO) at the bottom of the editor

3. In the 'Meta Description' field, write 150-160 characters describing the newsletter (e.g., 'Subscribe to Terp

Bros' monthly newsletter for exclusive strain reviews, product drops, and community updates.')

4. Click 'Update' to save

5. Repeat for all other pages showing missing meta descriptions in your audit report

6. If using Yoast SEO: go to SEO → Settings → Titles & Metas → enable 'Meta descriptions' and set a default

template for posts if none is provided

49. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

Your newsletter page doesn't have a meta description — the 160-character summary that appears below your

page title in Google search results. Without one, Google generates a random snippet from your page content,

which often looks unprofessional or doesn't clearly explain what visitors will find.

Why it matters for your business: Incomplete search results lower click-through rates from Google; potential

customers see a poorly formatted preview and choose a competitor's result instead.

Technical root cause: The WordPress page editor didn't populate the meta description field (usually managed

by Yoast SEO, Rank Math, or the native WordPress block editor). This is a common oversight on individual posts

or custom page types.

Recommended fix — step by step

1. Log into WordPress admin → Posts → The Slow Melt (or find it in your content library).

2. Scroll to the SEO plugin section (Yoast, Rank Math, etc.) or the native WordPress 'Document' panel on the

right sidebar.

3. Write a meta description: 150–160 characters that summarize the newsletter content and include your brand

name (e.g., 'Discover Terp Bros NYC monthly cannabis news, strain reviews, and exclusive updates in our

community newsletter.').

4. Click 'Update' or 'Publish' to save.

5. Repeat this process for any other newsletter or archive pages missing descriptions.

50. Missing meta description

https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/


Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about the Christmas newsletter is missing a meta description—the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random snippet from your

content, which may not be compelling or relevant to searchers.

Why it matters for your business: A weak or auto-generated description reduces click-through rate from

search results, losing potential customers who might otherwise visit your site to learn about your products or

newsletter.

Technical root cause: The WordPress post was published without manually filling in the meta description field

(typically in the Yoast SEO or All in One SEO plugin meta box below the editor), so no description was saved to

the page's HTML head tag.

Recommended fix — step by step

1. Log into WordPress admin → Posts → All Posts, find 'Blue and Yellow Christmas' post

2. Scroll to the Yoast SEO or All in One SEO meta box below the editor (or in the sidebar)

3. Click 'Edit snippet' or the preview area showing your page title

4. Write a 150–160 character description that includes your brand name and a benefit (e.g., 'Discover new

cannabis strains and exclusive Terp Bros updates in our monthly newsletter. Join the community.')

5. Click 'Save' within the meta box and then update the post

6. Repeat this process for any other blog posts missing descriptions using the Posts list view

51. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about Terpmas doesn't include a meta description — the 150–160 character summary that

appears below the page title in Google search results. Without it, Google generates a random snippet from your

content, which may not highlight your best selling points or call to action.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results

because customers see less compelling previews of your content, especially on mobile where space is tight.

Technical root cause: The WordPress post editor does not auto-generate meta descriptions; they must be

added manually via an SEO plugin (like Yoast SEO or Rank Math) or by editing the page's HTML head tag.

Recommended fix — step by step

1. Install Yoast SEO plugin (if not already active): WordPress Admin → Plugins → Add New → search 'Yoast

SEO' → Install and Activate.

https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/
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2. Edit the affected post: WordPress Admin → Posts → search 'it's beginning to look a lot like terpmas' → click

Edit.

3. Scroll down to the Yoast SEO meta box and locate the 'Snippet Editor' section.

4. Click in the meta description field and write a 150–160 character description: e.g., 'Terp Bros NYC December

newsletter: new product drops, holiday sales, and terpene education. Sign up for exclusive updates.'

5. Verify the preview shows your description in the snippet preview (green checkmark = good length).

6. Click Publish or Update to save.

7. Repeat for other blog posts missing descriptions by filtering your blog archive: Posts → filter by 'without

description' (if your SEO plugin offers this bulk view).

52. 7 image(s) missing alt text

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your site should have descriptive alt text — a short text description that explains what the image

shows. This text is read aloud by screen readers for visitors with low vision, and it also helps search engines

understand your images. Currently, 7 images on your Terpmas newsletter post have no alt text at all.

Why it matters for your business: Missing alt text reduces your SEO ranking for image search (potential lost

organic traffic) and blocks visually impaired customers from engaging with your content, which can trigger

accessibility complaints and limits your addressable audience.

Technical root cause: Images were likely uploaded to WordPress without filling in the 'Alt Text' field in the

media uploader, or inserted into posts without the alt attribute populated in the image block.

Recommended fix — step by step

1. Log in to WordPress dashboard → Posts → search for 'it's beginning to look a lot like terpmas' → click Edit

2. In the post editor, identify the first image and click it to open the image block settings panel on the right

3. In the 'Alt text' field, write a concise description (e.g., 'Festive Terp Bros holiday merchandise display' or

'Holiday cannabis strain gift box')

4. Repeat for all 7 images in the post, ensuring each alt text is 5–15 words and describes the image content

(not 'image' or 'photo')

5. Click Publish or Update to save changes

6. Going forward: When uploading new images, fill the 'Alt Text' field immediately in Media → Library → click

image → add alt text before inserting into posts

53. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/black-friday-at-terp-bros/

Rule: tier2.meta.no-description

https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/
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What it means (plain English)

Your Black Friday promotion page doesn't have a meta description — that's the 160-character summary that

appears below your page title in Google search results. Without it, Google generates a random snippet from

your page, which often looks unprofessional and doesn't tell customers why they should click.

Why it matters for your business: A missing meta description reduces click-through rate from search results,

meaning fewer customers see your promotion even if the page ranks.

Technical root cause: The page was likely created without filling in the WordPress meta description field, or

the SEO plugin (if present) wasn't activated for this post.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Black Friday at Terp Bros

2. Scroll to the Yoast SEO box (or All in One SEO / Rank Math, depending on your plugin) below the editor

3. Find the 'Meta description' field and write: 'Black Friday deals on premium cannabis at Terp Bros NYC.

Limited-time discounts on flower, edibles & more.' (keep it under 160 characters)

4. Click 'Update' to save

5. Check Google Search Console in 48–72 hours to confirm the new snippet appears in search results

54. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

Your thank-you page after newsletter signup is missing a meta description — the 160-character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a snippet that

looks unprofessional or doesn't explain what the page is about.

Why it matters for your business: Even though this is a post-signup page, missing descriptions on any public

page reduce click-through rates from search results and make your site appear unpolished to potential

customers researching Terp Bros.

Technical root cause: The WordPress page or post was published without a meta description field filled in. By

default, WordPress does not auto-generate these; they must be manually entered or set via an SEO plugin.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress admin → Plugins → Add New → search

'Yoast SEO' → Install and Activate

2. Navigate to WordPress admin → Pages (or Posts) and find the 'Thanks for giving a Terp Bros newsletter'

page

3. Scroll to the Yoast SEO meta box below the editor and click into the meta description field

4. Write a 150–160 character description, e.g., 'Thanks for subscribing to Terp Bros NYC newsletter. Stay

updated on products, events, and exclusive offers.'

5. Click 'Save' or 'Update' on the page

https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/


55. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This page doesn't have a meta description — the 160-character summary that appears under your page title in

Google search results. Without it, Google generates a random excerpt from your page content, which may not

highlight what makes this newsletter valuable to potential readers.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

people are less likely to visit your newsletter signup page if the preview looks generic or irrelevant.

Technical root cause: The WordPress page or post editor is missing a meta description field input, or the field

was left blank during creation. Many WordPress themes don't display the meta description field by default

unless a SEO plugin is active.

Recommended fix — step by step

1. Install the free Yoast SEO plugin: WordPress Admin → Plugins → Add New → search 'Yoast SEO' → Install

Now → Activate

2. Go to Posts → Edit the 'Run for it: A Terp Bros Newsletter' post

3. Scroll to the Yoast SEO panel at the bottom of the editor and find the 'Meta description' field

4. Write a 150–160 character description, e.g., 'Subscribe to Terp Bros' newsletter for exclusive cannabis strain

reviews, local NYC dispensary tips, and community events.'

5. Ensure the description includes a call-to-action or value proposition so it stands out in search results

6. Click 'Update' to save the post

56. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page doesn't include a meta description — a 155-character summary that appears below your

page title in Google search results. Without it, Google generates a random snippet from your content, which

often looks unprofessional and doesn't tell potential visitors why they should click.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

visitors are less likely to visit your blog content if they can't see a compelling preview, hurting traffic and

community engagement.

Technical root cause: The WordPress post or page editor wasn't filled out with a meta description field, or the

SEO plugin managing these descriptions (likely Yoast SEO or All in One SEO) was not configured for this post

type.

https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/
https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/


Recommended fix — step by step

1. Log in to WordPress admin and open Posts → All Posts; find 'Muchie Madness: A Terp Bros Munchletter'

2. Scroll to the SEO plugin section (Yoast SEO typically shows a 'Snippet' box; All in One SEO shows a 'SEO

Settings' panel below the editor)

3. Write a 155-character meta description: summarize the post's main topic and value (e.g., 'Discover trending

munchies, cannabis pairings, and snack hacks from the Terp Bros community.')

4. Click Save/Update on the post

5. Repeat for any other blog posts or key pages missing descriptions — prioritize high-traffic or revenue-

related pages first

57. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/

Rule: tier2.schema.none

What it means (plain English)

Your site is missing JSON-LD structured data — invisible code that tells Google what your pages are about. For

a blog post like 'Muchie Madness,' search engines can't automatically understand it's an article, who wrote it, or

when it was published. This makes it harder for Google to rank your content and show rich snippets (like star

ratings or publish dates) in search results.

Why it matters for your business: Without schema markup, your blog content ranks lower in search results

and doesn't stand out to potential customers browsing for cannabis community content — losing organic traffic

and engagement.

Technical root cause: WordPress isn't automatically generating JSON-LD blocks for posts. Either no SEO

plugin with schema support is active, or it's disabled/not configured for blog post types.

Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Admin → Plugins → Add New, search 'Yoast SEO', click Install

then Activate.

2. Go to Yoast SEO → General → Features and toggle ON 'Schema' if it's off.

3. Go to Yoast SEO → Search Appearance → Content Types → Posts, ensure 'Show in search results' is enabled

and schema type is set to 'Article'.

4. Edit the affected post (Muchie Madness) and scroll to the Yoast SEO block at the bottom; verify 'Focus

keyphrase' is filled in (e.g., 'cannabis munchies guide') — this triggers schema generation.

5. Click Publish or Update, then wait 5 minutes.

6. Paste https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/ into Google's Rich Results Test

(https://search.google.com/test/rich-results) to confirm 'Article' schema appears.

58. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/
https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/
https://search.google.com/test/rich-results)


Page URL: https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page is missing a meta description — the 155-character summary that appears under the page

title in Google search results. Without it, search engines will auto-generate a snippet, which is often choppy or

irrelevant and makes your post less clickable in search results.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

meaning fewer visitors discover your content and engage with your brand community.

Technical root cause: The WordPress post was published without manually entering a meta description in the

page editor, and no default description was generated by your SEO plugin or theme.

Recommended fix — step by step

1. Log in to WordPress → Posts → click 'Tacos, Time Capsules' post to edit

2. Scroll to the Yoast SEO or Rank Math box at the bottom of the editor (depending on which plugin you use)

3. In the 'Meta description' field, write a 150–160 character summary: e.g., 'Discover insider tips, strain

reviews, and Terp Bros updates in our latest community newsletter.'

4. Ensure the description includes a keyword naturally (e.g., 'Terp Bros' or 'cannabis newsletter') if relevant

5. Click Update to save

6. Set up a template for future posts: in your SEO plugin settings, create a default meta description rule for

blog posts (e.g., 'Blog: [Post Title] | Terp Bros Community') to auto-populate new posts

59. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your blog post pages are missing structured data — machine-readable code that tells Google what type of

content is on the page (in this case, a blog article). Without it, search engines have to guess the page's

purpose, which can hurt how it appears in search results and whether it shows up in specialized search features

like Google News or Knowledge Panels.

Why it matters for your business: Missing schema reduces the chance your blog content ranks well in Google

search results and limits visibility in rich search features, which directly impacts organic traffic to your site.

Technical root cause: WordPress doesn't automatically generate JSON-LD schema.org markup for blog posts.

Most sites either use an SEO plugin (like Yoast or Rank Math) or manually add schema code to their theme's

template files.

Recommended fix — step by step

1. Install a WordPress SEO plugin — Yoast SEO (free tier) or Rank Math (free tier) both auto-generate JSON-LD

schema for posts, pages, and your site structure.

2. Go to the plugin's settings and enable 'Schema' or 'Structured Data' output for blog posts.

https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/
https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/


3. Verify the schema is working: visit your blog post in a browser, view page source (Ctrl+F / Cmd+F), and

search for 'application/ld+json' — you should see a JSON block.

4. Test the page at Google Search Central's Rich Results Test (https://search.google.com/test/rich-results) to

confirm schema is valid and no errors appear.

5. If you prefer not to use a plugin, contact your developer to add Article schema manually to single.php in your

WordPress theme — this is more complex but gives you full control.

60. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page doesn't have a meta description — the short text snippet that appears below your page title

in Google search results. Without it, Google generates one automatically, which is often incomplete or poorly

formatted. This hurts click-through rates because potential customers can't see a compelling preview of what

the page offers.

Why it matters for your business: Lower search result click-through rates mean fewer visitors discovering

your newsletter content and brand voice, reducing community engagement and email signup opportunities.

Technical root cause: The WordPress post is missing the meta description field (typically in Yoast SEO, All in

One SEO, or the native WordPress block editor). Either it was never filled in, or the plugin that manages it is

misconfigured.

Recommended fix — step by step

1. Log into WordPress admin → Posts → edit 'Hotel Terpsylvania' post

2. If using Yoast SEO: scroll to the Yoast metabox at the bottom → paste a 150–160 character description in the

'Snippet Preview' meta description field

3. If using All in One SEO: find the metabox labeled 'AIOSEO' → enter description in the 'Meta Description' field

4. If neither plugin is active: install and activate Yoast SEO (free tier is sufficient), then repeat step 2

5. Craft a description that includes 'Terp Bros NYC' + newsletter topic + call-to-action (e.g., 'Stay updated on

cannabis trends, deals & community events. Read Hotel Terpsylvania, the official Terp Bros newsletter.')

6. Click 'Update' to save

7. Repeat for all blog posts / community content missing descriptions — use WordPress → Posts → bulk audit

with Yoast's readability tab to spot blanks

61. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

What it means (plain English)

https://search.google.com/test/rich-results)
https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/
https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/


Your blog post about Bavarian Pretzels doesn't have a meta description — a 160-character summary that

appears below your page title in Google search results. Without it, Google will auto-generate a snippet from

your content, which is often choppy or irrelevant. This reduces click-through rates from search.

Why it matters for your business: Lower click-through rates from Google Search mean fewer visitors to your

blog content, which directly impacts community engagement and time-on-site metrics that Google uses to rank

your entire domain.

Technical root cause: The WordPress post editor has a meta description field (usually in Yoast SEO or All in

One SEO plugin), but it was left blank when this post was published.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'Bavarian Pretzels Block Parties' post

2. Scroll to Yoast SEO box (or All in One SEO) at the bottom of the editor

3. Click 'Edit snippet' or similar button to expand meta description field

4. Write a 155–160 character description: e.g., 'Join Terp Bros NYC for Bavarian pretzels at our next block

party. Community events, exclusive drops, and good vibes every weekend.'

5. Click 'Save' or 'Update post'

6. Repeat for any other blog posts missing meta descriptions: use WordPress admin → Posts → filter by 'All

Posts' and spot-check 5–10 recent entries

62. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/

Rule: tier2.schema.none

What it means (plain English)

Your blog post pages don't include JSON-LD structured data—a machine-readable format that tells Google

what your content is about (e.g., a news article, event, product). Without it, search engines have to guess the

page type and may not display rich results like snippets, ratings, or event details in search listings.

Why it matters for your business: Missing schema reduces your chances of appearing in Google's featured

snippets and Knowledge Panel for cannabis-related news or events, limiting organic traffic and brand visibility in

search results.

Technical root cause: WordPress theme or plugins are not outputting JSON-LD blocks. Most WordPress SEO

plugins (Yoast, Rank Math, All in One SEO) generate this automatically, but they may not be installed, activated,

or configured for blog post types.

Recommended fix — step by step

1. Log in to WordPress admin → Plugins → Search for 'Yoast SEO' (free version). Install and activate if not

present.

2. Go to Yoast SEO → General → Features → toggle 'Schema' to ON if it's off.

3. Navigate to the affected blog post (Bavarian Pretzels…) and open the Yoast SEO sidebar on the right.

4. Under 'Schema' tab, ensure 'Article' is selected. If it shows 'None', click 'Change schema type' and pick

'Article'.

5. Publish/update the post, then test the page URL in Google's Rich Results Test

(https://search.google.com/test/rich-results) to confirm schema is now detected.

https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/
https://search.google.com/test/rich-results)


6. Repeat for other blog posts, or enable schema site-wide in Yoast settings so all future posts auto-generate

it.

63. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about your Forest Hills Kiwanis networking event is missing a meta description—the short text

(150–160 characters) that appears under your page title in Google search results. Without it, Google will auto-

generate a snippet from your page content, which may not highlight the most compelling details about the

event.

Why it matters for your business: A weak or auto-generated description reduces click-through rates from

search results, meaning fewer people visit the event page even if it ranks well; this directly hurts attendance

and community engagement for Terp Bros.

Technical root cause: The WordPress page editor did not have a meta description field populated, or the SEO

plugin (if present) was not configured to require or prompt for descriptions during publishing.

Recommended fix — step by step

1. Log in to WordPress admin → go to Posts → edit the Forest Hills Kiwanis event post

2. If using Yoast SEO plugin: scroll to the Yoast SEO metabox at the bottom → find 'Meta description' field →

enter a 150–160 character description (e.g., 'Join Terp Bros at Forest Hills Kiwanis for community

networking, industry insights, and exclusive cannabis retail partnerships.')

3. If no SEO plugin is active: install Yoast SEO (Plugins → Add New → search 'Yoast SEO' → Install Now →

Activate)

4. After adding the description, click Update to publish the change

5. Repeat this process for all other blog/event posts missing descriptions: use WordPress → Posts → bulk

search by sorting by date, or run a quick audit using Screaming Frog (free tier) to identify all pages without

descriptions

64. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/

Rule: tier2.meta.no-description

What it means (plain English)

Meta descriptions are the 2–3 sentence summaries that appear below your page title in Google search results.

This blog post about a Curaleaf conversation is missing that description, so Google will auto-generate a snippet

from your page content — which often looks choppy and unprofessional to potential visitors.

https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/
https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/


Why it matters for your business: Without a custom meta description, your search results compete poorly on

click-through rate; visitors see a truncated or irrelevant excerpt instead of your message, reducing traffic to

your community content.

Technical root cause: The WordPress post or page was published without filling in the meta description field

(typically in Yoast SEO, Rank Math, or the native WordPress block editor's excerpt/description panel).

Recommended fix — step by step

1. Log in to WordPress admin → go to Posts → find 'NY State of Mind with Curaleaf Conversation with Boris

Jordan'

2. If using Yoast SEO plugin: scroll to the Yoast metabox → click the 'Snippet editor' toggle → paste a 155–160

character description: e.g., 'Curaleaf co-founder Boris Jordan discusses cannabis innovation, industry

trends, and NYC's emerging dispensary market in an exclusive interview.'

3. If using Rank Math: scroll to Rank Math metabox → click Snippet editor → enter the same description

4. If neither plugin is active: use the native WordPress 'Excerpt' field (bottom right of post editor) to write the

same description

5. Click Update/Publish

6. Repeat this process for all other community posts missing descriptions — audit your blog archive to find

them

65. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

66. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

67. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/green-wednesday-at-terp-bros/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/
https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/green-wednesday-at-terp-bros/


68. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

69. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

70. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

71. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

72. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/
https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/
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73. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

74. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

75. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

76. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

77. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/
https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/
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78. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

79. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

80. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

81. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

82. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/
https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/
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83. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

84. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

85. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

86. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

87. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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88. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

89. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

90. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

91. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

92. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/
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https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/
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93. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

94. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

95. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

96. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

97. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/
https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/
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98. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

99. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

100. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

101. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

102. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/
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103. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-

and-widowmaker-strains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

104. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-

and-widowmaker-strains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

105. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-

and-widowmaker-strains/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

106. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

107. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/

Rule: tier2.schema.none

Detail

https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
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Page has no JSON-LD structured data blocks.

108. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

109. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

110. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

111. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

112. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/
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113. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

114. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

115. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

116. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

117. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/
https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/
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118. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

119. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

120. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

121. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-

hybrid/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

122. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-

hybrid/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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123. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-

hybrid/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

124. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

125. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

126. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

127. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/
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128. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

129. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

130. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

131. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

132. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/
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133. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

134. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

135. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

136. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

137. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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138. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

139. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

140. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

141. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

142. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/
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143. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

144. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

145. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-skydiving-event/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

146. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-skydiving-event/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

147. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-skydiving-event/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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148. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

149. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

150. 10 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

151. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

152. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/
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153. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

154. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-

apple/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

155. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-

apple/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

156. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-

apple/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

157. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/summer-terpin-had-me-a-blast/

Rule: tier2.meta.no-description

Detail

https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/
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Page has no meta description.

158. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/summer-terpin-had-me-a-blast/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

159. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/summer-terpin-had-me-a-blast/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

160. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

161. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

162. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/summer-terpin-had-me-a-blast/
https://terpbrosnyc.com/summer-terpin-had-me-a-blast/
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163. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

164. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

165. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

166. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

167. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/
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168. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

169. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

170. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

171. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

172. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-summertime/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/
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173. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-summertime/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

174. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-summertime/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

175. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

176. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

177. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/terp-bros-newsletter-summertime/
https://terpbrosnyc.com/terp-bros-newsletter-summertime/
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178. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

179. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

180. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

181. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

182. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/
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183. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

184. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

185. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

186. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

187. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/
https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/
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188. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

189. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

190. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-dog-days/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

191. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-dog-days/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

192. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-dog-days/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/
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193. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-

dispensaries/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

194. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-

dispensaries/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

195. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-

dispensaries/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

196. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

197. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/

Rule: tier2.schema.none

Detail

https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/
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Page has no JSON-LD structured data blocks.

198. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

199. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

200. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

201. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

202. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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203. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

204. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

205. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

206. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

207. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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208. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/__trashed/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

209. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/__trashed/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

210. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/__trashed/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

211. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

212. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/__trashed/
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213. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

214. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

215. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

216. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

217. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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218. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

219. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

220. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

221. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

222. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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223. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

224. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

225. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

226. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

227. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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228. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

229. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

230. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

231. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

232. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-

nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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233. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-

nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

234. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-

nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

235. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-local-astoria-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

236. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-local-astoria-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

237. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-local-astoria-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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238. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

239. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

240. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

241. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

242. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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243. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

244. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

245. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

246. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

247. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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248. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

249. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

250. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

251. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

252. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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253. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

254. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

255. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

256. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

257. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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258. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

259. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

260. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

261. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

262. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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263. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

264. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

265. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

266. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

267. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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268. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

269. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

270. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

271. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

272. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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273. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

274. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

275. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

276. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

277. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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278. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

279. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

280. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astorias-cannabis-hotspots-where-to-shop/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

281. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astorias-cannabis-hotspots-where-to-shop/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

282. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astorias-cannabis-hotspots-where-to-shop/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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283. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

284. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

285. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

286. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

287. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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288. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

289. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-

guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

290. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-

guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

291. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-

guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

292. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/

Rule: tier2.meta.no-description

Detail

https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/


Page has no meta description.

293. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

294. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

295. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

296. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

297. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/
https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/
https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/
https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/
https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/


298. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-

from-terp-bros/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

299. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-

from-terp-bros/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

300. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-

from-terp-bros/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

301. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

302. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/

Rule: tier2.schema.none

Detail

https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/
https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/


Page has no JSON-LD structured data blocks.

303. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

304. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

305. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

306. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

307. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/
https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/
https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/
https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/
https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/


308. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

309. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

310. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

311. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

312. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/
https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/
https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/
https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/
https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/


313. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

314. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

315. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

316. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

317. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/
https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/
https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/
https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/
https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/


318. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

319. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

320. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

321. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

322. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/
https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/
https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/
https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/
https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/


323. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

324. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

325. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/420-photo-recap/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

326. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/420-photo-recap/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

327. 26 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/420-photo-recap/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/
https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/
https://terpbrosnyc.com/420-photo-recap/
https://terpbrosnyc.com/420-photo-recap/
https://terpbrosnyc.com/420-photo-recap/


328. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

329. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

330. 25 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

331. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/vegan-love-joint-recap-photos/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

332. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/vegan-love-joint-recap-photos/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/
https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/
https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/
https://terpbrosnyc.com/vegan-love-joint-recap-photos/
https://terpbrosnyc.com/vegan-love-joint-recap-photos/


333. 18 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/vegan-love-joint-recap-photos/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

334. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

335. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

336. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

337. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/vegan-love-joint-recap-photos/
https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/
https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/
https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/
https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/


338. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

339. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

340. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

341. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

342. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/
https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/
https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/
https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/
https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/


343. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

344. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

345. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

346. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

347. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/
https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/
https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/
https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/
https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/


348. 12 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

349. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

350. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

351. 13 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

352. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/queens-fight-club-press-conference/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/
https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/
https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/
https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/
https://terpbrosnyc.com/queens-fight-club-press-conference/


353. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/queens-fight-club-press-conference/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

354. 10 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/queens-fight-club-press-conference/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

355. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

356. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

357. 7 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/queens-fight-club-press-conference/
https://terpbrosnyc.com/queens-fight-club-press-conference/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/


358. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

359. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

360. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

361. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

362. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/


363. 16 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

364. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

365. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

366. 16 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

367. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/
https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/


368. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

369. 13 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

370. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

371. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

372. 19 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/
https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/


373. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

374. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

375. 13 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

376. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

377. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/
https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/
https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/
https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/
https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/


378. 14 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

379. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

380. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

381. 17 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

382. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/
https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/
https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/
https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/


383. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

384. 16 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

385. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

386. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

387. 19 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/
https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/
https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/
https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/
https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/


388. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

389. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

390. 48 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

391. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/our-story/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

392. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/our-story/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/our-story/
https://terpbrosnyc.com/our-story/


393. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/our-story/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

394. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/blog/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

395. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/blog/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

396. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/blog/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

397. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/contact-us/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/our-story/
https://terpbrosnyc.com/blog/
https://terpbrosnyc.com/blog/
https://terpbrosnyc.com/blog/
https://terpbrosnyc.com/contact-us/


398. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/contact-us/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

399. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/contact-us/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

400. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/faqs/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

401. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/faqs/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

402. 5 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/faqs/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/contact-us/
https://terpbrosnyc.com/contact-us/
https://terpbrosnyc.com/faqs/
https://terpbrosnyc.com/faqs/
https://terpbrosnyc.com/faqs/


403. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

404. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

405. 45 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

406. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

407. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/ozone-park/
https://terpbrosnyc.com/ozone-park/
https://terpbrosnyc.com/ozone-park/
https://terpbrosnyc.com/astoria/
https://terpbrosnyc.com/astoria/


408. 39 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

409. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/flower/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

410. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/flower/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

411. 22 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/flower/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

412. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/astoria/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/cannabis-delivery/


413. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

414. 15 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

415. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/in-store-pick-up/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

416. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/in-store-pick-up/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

417. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/in-store-pick-up/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/cannabis-delivery/
https://terpbrosnyc.com/cannabis-delivery/
https://terpbrosnyc.com/in-store-pick-up/
https://terpbrosnyc.com/in-store-pick-up/
https://terpbrosnyc.com/in-store-pick-up/


418. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/online-ordering/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

419. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/online-ordering/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

420. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/online-ordering/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

421. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/loyalty-program/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

422. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/loyalty-program/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/online-ordering/
https://terpbrosnyc.com/online-ordering/
https://terpbrosnyc.com/online-ordering/
https://terpbrosnyc.com/loyalty-program/
https://terpbrosnyc.com/loyalty-program/


423. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/loyalty-program/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

424. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/press/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

425. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/press/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

426. 17 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/press/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

427. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/about-us/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/loyalty-program/
https://terpbrosnyc.com/press/
https://terpbrosnyc.com/press/
https://terpbrosnyc.com/press/
https://terpbrosnyc.com/about-us/


428. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/about-us/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

429. 11 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/about-us/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

430. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-101/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

431. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-101/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

432. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/cannabis-101/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/about-us/
https://terpbrosnyc.com/about-us/
https://terpbrosnyc.com/cannabis-101/
https://terpbrosnyc.com/cannabis-101/
https://terpbrosnyc.com/cannabis-101/


433. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/recreational-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

434. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/recreational-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

435. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/recreational-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

436. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/jeeter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

437. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/jeeter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/recreational-cannabis/
https://terpbrosnyc.com/recreational-cannabis/
https://terpbrosnyc.com/recreational-cannabis/
https://terpbrosnyc.com/jeeter/
https://terpbrosnyc.com/jeeter/


438. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/jeeter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

439. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/mfny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

440. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/mfny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

441. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/mfny/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

442. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/puff/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/jeeter/
https://terpbrosnyc.com/mfny/
https://terpbrosnyc.com/mfny/
https://terpbrosnyc.com/mfny/
https://terpbrosnyc.com/puff/


443. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/puff/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

444. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/puff/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

445. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/dank-by-definition/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

446. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/dank-by-definition/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

447. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/dank-by-definition/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/puff/
https://terpbrosnyc.com/puff/
https://terpbrosnyc.com/dank-by-definition/
https://terpbrosnyc.com/dank-by-definition/
https://terpbrosnyc.com/dank-by-definition/


448. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/nanticoke/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

449. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/nanticoke/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

450. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/nanticoke/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

451. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/olio/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

452. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/olio/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/nanticoke/
https://terpbrosnyc.com/nanticoke/
https://terpbrosnyc.com/nanticoke/
https://terpbrosnyc.com/olio/
https://terpbrosnyc.com/olio/


453. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/olio/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

454. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/jetty/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

455. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/jetty/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

456. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/jetty/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

457. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/back-home-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/olio/
https://terpbrosnyc.com/jetty/
https://terpbrosnyc.com/jetty/
https://terpbrosnyc.com/jetty/
https://terpbrosnyc.com/back-home-cannabis/


458. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/back-home-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

459. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/back-home-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

460. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

461. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

462. 13 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/back-home-cannabis/
https://terpbrosnyc.com/back-home-cannabis/
https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/
https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/
https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/


463. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

464. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

465. 11 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

466. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

467. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/
https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/
https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/
https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/
https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/


468. 11 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

469. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

470. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

471. 12 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

472. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/
https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/
https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/
https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/
https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/


473. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

474. 10 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

475. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/dispensary-near-me/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

476. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/dispensary-near-me/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

477. 12 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/dispensary-near-me/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/
https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/
https://terpbrosnyc.com/astoria/dispensary-near-me/
https://terpbrosnyc.com/astoria/dispensary-near-me/
https://terpbrosnyc.com/astoria/dispensary-near-me/


478. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

479. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

480. 11 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

481. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

482. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/
https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/
https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/
https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/
https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/


483. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

484. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

485. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

486. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

487. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/
https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/
https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/
https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/
https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/


488. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

489. 10 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

490. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

491. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

492. 10 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/
https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/
https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/
https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/
https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/


493. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

494. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

495. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

496. Missing canonical

Severity: P2

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

497. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/
https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/
https://terpbrosnyc.com/category/blog/
https://terpbrosnyc.com/category/blog/
https://terpbrosnyc.com/category/blog/


498. 9 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

499. Missing meta description

Severity: P2

Page URL: https://terpbrosnyc.com/author/servicebudauthority-com/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

500. Missing canonical

Severity: P2

Page URL: https://terpbrosnyc.com/author/servicebudauthority-com/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

501. No JSON-LD schema

Severity: P2

Page URL: https://terpbrosnyc.com/author/servicebudauthority-com/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

502. 8 image(s) missing alt text

Severity: P2

Page URL: https://terpbrosnyc.com/author/servicebudauthority-com/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://terpbrosnyc.com/category/blog/
https://terpbrosnyc.com/author/servicebudauthority-com/
https://terpbrosnyc.com/author/servicebudauthority-com/
https://terpbrosnyc.com/author/servicebudauthority-com/
https://terpbrosnyc.com/author/servicebudauthority-com/


503. Slow LCP (desktop): 1916ms

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier3.cwv.lcp-desktop

Detail

Largest Contentful Paint 1916ms exceeds 1800ms target.

504. Missing core schema types: Organization, LocalBusiness, WebSite

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier4.schema.missing-core

Detail

Every site should emit Organization + LocalBusiness + WebSite JSON-LD.

505. Missing security header: content-security-policy

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier5.header.content-security-policy

Detail

content-security-policy not present on homepage response. Affects fortress score and CSP posture.

506. 11 tap targets under 44px at mobile-320

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

507. 11 tap targets under 44px at mobile-375

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/


508. 11 tap targets under 44px at mobile-414

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

509. 15 tap targets under 44px at tablet-768

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

510. Lighthouse perf (desktop): 70/100

Severity: P2

Page URL: https://terpbrosnyc.com/

Rule: tier8.lighthouse.perf-desktop

Detail

Score 70 is below target 90. See HTML report for details.

P3 — 416 findings

1. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

2. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/
https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/


Detail

No twitter:card meta tag.

3. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

4. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

5. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

6. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

7. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/
https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/
https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/
https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/
https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/


Page missing og:title and/or og:image.

8. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

9. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

10. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

11. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

12. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/
https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/
https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/
https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/


13. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

14. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

15. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

16. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

17. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/
https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/


18. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

19. Title length 77 chars

Severity: P3

Page URL: https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "It’s Beginning To Look A Lot Like Terpmas: A Terp Bros Newsletter – Terp

Bros"

20. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

21. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

22. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/black-friday-at-terp-bros/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/black-friday-at-terp-bros/


23. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/black-friday-at-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

24. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/green-wednesday-at-terp-bros/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

25. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/green-wednesday-at-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

26. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

27. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/black-friday-at-terp-bros/
https://terpbrosnyc.com/green-wednesday-at-terp-bros/
https://terpbrosnyc.com/green-wednesday-at-terp-bros/
https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/
https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/


28. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

29. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

30. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

31. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

32. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/
https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/
https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/
https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/
https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/


33. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

34. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

35. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

36. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

37. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/
https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/
https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/
https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/
https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/


38. Title length 78 chars

Severity: P3

Page URL: https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "5th Annual Miles for MBC and Kelly Marie Presents The # LightUpMBC – Terp

Bros"

39. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

40. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

41. Title length 69 chars

Severity: P3

Page URL: https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Bavarian Pretzels & Block Parties: A Terp Bros Newsletter – Terp Bros"

42. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/
https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/
https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/
https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/
https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/


43. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

44. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

45. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

46. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

47. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/
https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/
https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/
https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/
https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/


48. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

49. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

50. Title length 75 chars

Severity: P3

Page URL: https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "NY State of Mind with Curaleaf – Conversation with Boris Jordan – Terp

Bros"

51. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

52. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/
https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/
https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/
https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/
https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/


53. Title length 68 chars

Severity: P3

Page URL: https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sweater Weather (But Not Really): A Terp Bros Newsletter – Terp Bros"

54. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

55. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

56. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

57. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/
https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/
https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/


58. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

59. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

60. Title length 76 chars

Severity: P3

Page URL: https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "STIIIZY’s Roots: Discovering the Visionaries Who Built the Brand – Terp Bros"

61. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

62. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/
https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/
https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/
https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/
https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-built-the-brand/


63. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

64. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

65. Title length 79 chars

Severity: P3

Page URL: https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sip, Savor, Soothe: The Sweet Science of Blackberry Lemonade Pearls – Terp

Bros"

66. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

67. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/
https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/
https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/
https://terpbrosnyc.com/sip-savor-soothe-the-sweet-science-of-blackberry-lemonade-pearls/


68. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

69. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

70. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

71. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

72. Title length 71 chars

Severity: P3

Page URL: https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "All About Durban Fruit: Your Guide to This Flavorful Strain – Terp Bros"

https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/
https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/
https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/
https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/
https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/


73. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

74. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

75. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Cherry Zoap Experience: What Makes This Strain Sparkle – Terp Bros"

76. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

77. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/
https://terpbrosnyc.com/all-about-durban-fruit-your-guide-to-this-flavorful-strain/
https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/
https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/
https://terpbrosnyc.com/the-cherry-zoap-experience-what-makes-this-strain-sparkle/


78. Title length 102 chars

Severity: P3

Page URL: https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-

and-widowmaker-strains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Discover Your Next Favorite: Exploring Sweet BB Haze, Sweet Gelato, and

Widowmaker Strains – Terp Bros"

79. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-

and-widowmaker-strains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

80. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-

and-widowmaker-strains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

81. Title length 72 chars

Severity: P3

Page URL: https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cherry Beltz Strain Your Ultimate Guide to This Sweet Indica – Terp Bros"

82. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/

Rule: tier2.meta.no-og

Detail

https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
https://terpbrosnyc.com/discover-your-next-favorite-exploring-sweet-bb-haze-sweet-gelato-and-widowmaker-strains/
https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/
https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/


Page missing og:title and/or og:image.

83. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

84. Title length 69 chars

Severity: P3

Page URL: https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Seamless Shopping: How to Buy Online and Pick Up In Store – Terp Bros"

85. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

86. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

87. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/cherry-beltz-strain-your-ultimate-guide-to-this-sweet-indica/
https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/
https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/
https://terpbrosnyc.com/seamless-shopping-how-to-buy-online-and-pick-up-in-store/
https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/


88. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

89. Title length 77 chars

Severity: P3

Page URL: https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Unleash the Power: Top Electric Dab Rigs for Every Budget in 2025 – Terp

Bros"

90. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

91. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

92. Title length 74 chars

Severity: P3

Page URL: https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Apple Bomb Strain: Effects, Genetics, and Where to Find It – Terp Bros"

https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/
https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/
https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/
https://terpbrosnyc.com/unleash-the-power-top-electric-dab-rigs-for-every-budget-in-2025/
https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/


93. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

94. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

95. Title length 89 chars

Severity: P3

Page URL: https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-

hybrid/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Ultimate Guide to Strain Types: Is Your Kush Indica, Sativa, or a Hybrid?

– Terp Bros"

96. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-

hybrid/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

97. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-

hybrid/

Rule: tier2.meta.no-twitter-card

Detail

https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/
https://terpbrosnyc.com/the-apple-bomb-strain-effects-genetics-and-where-to-find-it/
https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/
https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/
https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/
https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/
https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/
https://terpbrosnyc.com/the-ultimate-guide-to-strain-types-is-your-kush-indica-sativa-or-a-hybrid/


No twitter:card meta tag.

98. Title length 71 chars

Severity: P3

Page URL: https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Grow Your Own Legend: Everything About Jack Herer Automatic – Terp Bros"

99. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

100. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

101. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Cannabis Cured Recall: What Consumers Need to Know Now – Terp

Bros"

102. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/

Rule: tier2.meta.no-og

Detail

https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/
https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/
https://terpbrosnyc.com/grow-your-own-legend-everything-about-jack-herer-automatic/
https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/
https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/


Page missing og:title and/or og:image.

103. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

104. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

105. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

106. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

107. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/the-cannabis-cured-recall-what-consumers-need-to-know-now/
https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/
https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/
https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/
https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/


108. Title length 76 chars

Severity: P3

Page URL: https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Your Nightcap Just Got Interesting: A Guide to Edibles for Sleep – Terp Bros"

109. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

110. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

111. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

112. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/
https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/
https://terpbrosnyc.com/your-nightcap-just-got-interesting-a-guide-to-edibles-for-sleep/
https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/
https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/


113. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

114. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

115. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-skydiving-event/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

116. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-skydiving-event/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

117. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/
https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/
https://terpbrosnyc.com/terp-bros-skydiving-event/
https://terpbrosnyc.com/terp-bros-skydiving-event/
https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/


118. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

119. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Skywalker Strain: Your Guide to Its Indica-Sativa Identity – Terp Bros"

120. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

121. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

122. Title length 81 chars

Severity: P3

Page URL: https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-

apple/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Green on the Go: The Ultimate Guide to Weed Delivery in the Big Apple –

Terp Bros"

https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/
https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/
https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/
https://terpbrosnyc.com/skywalker-strain-your-guide-to-its-indica-sativa-identity/
https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-apple/
https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-apple/


123. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-

apple/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

124. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-

apple/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

125. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/summer-terpin-had-me-a-blast/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

126. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/summer-terpin-had-me-a-blast/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

127. Title length 67 chars

Severity: P3

Page URL: https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Times in Brooklyn: Finding Your Perfect Dispensary – Terp Bros"

https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-apple/
https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-apple/
https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-apple/
https://terpbrosnyc.com/green-on-the-go-the-ultimate-guide-to-weed-delivery-in-the-big-apple/
https://terpbrosnyc.com/summer-terpin-had-me-a-blast/
https://terpbrosnyc.com/summer-terpin-had-me-a-blast/
https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/


128. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

129. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

130. Title length 72 chars

Severity: P3

Page URL: https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Camino Gummies Reviewed: Are They the Best Cannabis Edibles? – Terp

Bros"

131. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

132. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/
https://terpbrosnyc.com/high-times-in-brooklyn-finding-your-perfect-dispensary/
https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/
https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/
https://terpbrosnyc.com/camino-gummies-reviewed-are-they-the-best-cannabis-edibles/


133. Title length 73 chars

Severity: P3

Page URL: https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Get Zesty: A Deep Dive into Lemonatti Strain’s Potent Effects – Terp Bros"

134. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

135. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

136. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

137. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/
https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/
https://terpbrosnyc.com/get-zesty-a-deep-dive-into-lemonatti-strains-potent-effects/
https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/
https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-gummies/


138. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-summertime/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

139. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-summertime/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

140. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

141. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

142. Title length 71 chars

Severity: P3

Page URL: https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dab Day Decoded: Celebrating 7/10, the Cannabis Oil Holiday – Terp Bros"

https://terpbrosnyc.com/terp-bros-newsletter-summertime/
https://terpbrosnyc.com/terp-bros-newsletter-summertime/
https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/
https://terpbrosnyc.com/stay-safe-tracking-fires-in-riverhead-ny/
https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/


143. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

144. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

145. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

146. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

147. Title length 66 chars

Severity: P3

Page URL: https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jamaica’s Green Scene: Where to Find Legal Ganja Shops – Terp Bros"

https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/
https://terpbrosnyc.com/dab-day-decoded-celebrating-7-10-the-cannabis-oil-holiday/
https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/
https://terpbrosnyc.com/where-to-buy-1-gram-disposable-thc-vapes-online/
https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/


148. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

149. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

150. Title length 76 chars

Severity: P3

Page URL: https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Secret Sauce: Crafting Perfect Cannabis Oil for Your Kitchen – Terp

Bros"

151. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

152. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/
https://terpbrosnyc.com/jamaicas-green-scene-where-to-find-legal-ganja-shops/
https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/
https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/
https://terpbrosnyc.com/the-secret-sauce-crafting-perfect-cannabis-oil-for-your-kitchen/


153. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-dog-days/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

154. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-newsletter-dog-days/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

155. Title length 82 chars

Severity: P3

Page URL: https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-

dispensaries/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Your 5-Mile Green Zone: A Guide to Finding Local Cannabis Dispensaries –

Terp Bros"

156. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-

dispensaries/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

157. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-

dispensaries/

Rule: tier2.meta.no-twitter-card

Detail

https://terpbrosnyc.com/terp-bros-newsletter-dog-days/
https://terpbrosnyc.com/terp-bros-newsletter-dog-days/
https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/
https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/
https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/
https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/
https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/
https://terpbrosnyc.com/your-5-mile-green-zone-a-guide-to-finding-local-cannabis-dispensaries/


No twitter:card meta tag.

158. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Twinkle All the Way Through Dyker Heights Christmas Lights – Terp Bros"

159. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

160. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

161. Title length 68 chars

Severity: P3

Page URL: https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "PAX Era Pro Pods Uncovered – Find Your Perfect Pod Match – Terp Bros"

162. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/
https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/
https://terpbrosnyc.com/twinkle-all-the-way-through-dyker-heights-christmas-lights/
https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/
https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/


163. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

164. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

165. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

166. Title length 76 chars

Severity: P3

Page URL: https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Heads Up Trading Co: Your One-Stop Shop for Metaphysical Marvels – Terp

Bros"

167. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/pax-era-pro-pods-uncovered-find-your-perfect-pod-match/
https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/
https://terpbrosnyc.com/dayz-driving-school-how-not-to-crash-your-ada-4x4/
https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/
https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/


168. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

169. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/__trashed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

170. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/__trashed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

171. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

172. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/heads-up-trading-co-your-one-stop-shop-for-metaphysical-marvels/
https://terpbrosnyc.com/__trashed/
https://terpbrosnyc.com/__trashed/
https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/
https://terpbrosnyc.com/terpene-talk-understanding-cannabis-aromas/


173. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

174. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

175. Title length 73 chars

Severity: P3

Page URL: https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "App-solutely Delicious: Comparing the Best Food Delivery Apps – Terp Bros"

176. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

177. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/
https://terpbrosnyc.com/tiny-but-mighty-discover-the-best-mini-bongs/
https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/
https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/
https://terpbrosnyc.com/app-solutely-delicious-comparing-the-best-food-delivery-apps/


178. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

179. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

180. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

181. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

182. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/
https://terpbrosnyc.com/astoria-spring-cannabis-products-local-events-guide/
https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/
https://terpbrosnyc.com/marijuana-delivery-near-me-a-comprehensive-guide/
https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/


183. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

184. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

185. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

186. Title length 136 chars

Severity: P3

Page URL: https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-

nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Door to Door: The Ultimate Guide to Cannabis Delivery in NYCCannabis

delivery NYC: Top 2025 Guide to Convenient Service – Terp Bros"

187. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-

nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/

Rule: tier2.meta.no-og

Detail

https://terpbrosnyc.com/hybrid-weed-explained-what-you-need-to-know/
https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/
https://terpbrosnyc.com/gummy-goodness-exploring-the-world-of-thc-edibles/
https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/
https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/
https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/
https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/


Page missing og:title and/or og:image.

188. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-

nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

189. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-local-astoria-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

190. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-local-astoria-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

191. Title length 69 chars

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Astoria Dispensary Delights: Where to Find Your Next High – Terp Bros"

192. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/

Rule: tier2.meta.no-og

Detail

https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/
https://terpbrosnyc.com/from-door-to-door-the-ultimate-guide-to-cannabis-delivery-in-nyccannabis-delivery-nyc-top-2025-guide-to-convenient-service/
https://terpbrosnyc.com/terp-bros-local-astoria-guide/
https://terpbrosnyc.com/terp-bros-local-astoria-guide/
https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/
https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/


Page missing og:title and/or og:image.

193. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

194. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

195. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

196. Title length 69 chars

Severity: P3

Page URL: https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Get Your Green: How to Access Cannabis Delivery in Queens – Terp Bros"

197. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/astoria-dispensary-delights-where-to-find-your-next-high/
https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/
https://terpbrosnyc.com/vaporize-the-myths-how-vaporizers-work/
https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/
https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/


198. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

199. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

200. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

201. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Delivery Demystified: Everything You Need to Know – Terp Bros"

202. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/get-your-green-how-to-access-cannabis-delivery-in-queens/
https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/
https://terpbrosnyc.com/your-guide-to-legal-weed-in-astoria/
https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/
https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/


203. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

204. Title length 73 chars

Severity: P3

Page URL: https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Elevate Your Layover: Top Dispensaries Near LaGuardia Airport – Terp Bros"

205. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

206. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

207. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/cannabis-delivery-demystified-everything-you-need-to-know/
https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/
https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/
https://terpbrosnyc.com/elevate-your-layover-top-dispensaries-near-laguardia-airport/
https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/


208. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

209. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

210. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

211. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

212. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/the-kiva-experience-discovering-cannabis-edibles/
https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/
https://terpbrosnyc.com/cannabis-clues-how-to-identify-different-strains/
https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/
https://terpbrosnyc.com/7-reasons-why-you-will-love-these-cannabis-strains/


213. Title length 71 chars

Severity: P3

Page URL: https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Electric Dab Rigs: A Shocking Comparison of the Best Models – Terp Bros"

214. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

215. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

216. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "THC Carts 101: The Beginner’s Guide to Cannabis Cartridges – Terp Bros"

217. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/
https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/
https://terpbrosnyc.com/electric-dab-rigs-a-shocking-comparison-of-the-best-models/
https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/
https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/


218. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

219. Title length 68 chars

Severity: P3

Page URL: https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Screen to Green: Your Guide to Ordering Weed Online – Terp Bros"

220. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

221. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

222. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/thc-carts-101-the-beginners-guide-to-cannabis-cartridges/
https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/
https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/
https://terpbrosnyc.com/from-screen-to-green-your-guide-to-ordering-weed-online/
https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/


223. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

224. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

225. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

226. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astorias-cannabis-hotspots-where-to-shop/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

227. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astorias-cannabis-hotspots-where-to-shop/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/queens-green-express-how-to-order-cannabis-delivery/
https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/
https://terpbrosnyc.com/from-flower-to-flour-understanding-cannabis-edibles/
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228. Title length 69 chars

Severity: P3

Page URL: https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Everything You Need to Know About Weed Delivery in Queens – Terp Bros"

229. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

230. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

231. Title length 77 chars

Severity: P3

Page URL: https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Uptown to Downtown: NYC’s Premier Cannabis Delivery Services –

Terp Bros"

232. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/
https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/
https://terpbrosnyc.com/everything-you-need-to-know-about-weed-delivery-in-queens/
https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/
https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/


233. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

234. Title length 86 chars

Severity: P3

Page URL: https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-

guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Finding Your Perfect Dispensary in Long Island City: A Comprehensive Guide

– Terp Bros"

235. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-

guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

236. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-

guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

237. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/

Rule: tier2.meta.no-og

Detail

https://terpbrosnyc.com/from-uptown-to-downtown-nycs-premier-cannabis-delivery-services/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
https://terpbrosnyc.com/finding-your-perfect-dispensary-in-long-island-city-a-comprehensive-guide/
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https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/


Page missing og:title and/or og:image.

238. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

239. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

240. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

241. Title length 94 chars

Severity: P3

Page URL: https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-

from-terp-bros/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Special Delivery Strands: Get Your Favorite Cannabis Delivered Fast from

Terp Bros – Terp Bros"

242. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-

from-terp-bros/

Rule: tier2.meta.no-og

https://terpbrosnyc.com/bud-on-demand-nycs-top-delivery-services/
https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/
https://terpbrosnyc.com/peak-pro-puffco-the-ultimate-vaporizer/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/


Detail

Page missing og:title and/or og:image.

243. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-

from-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

244. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

245. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

246. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

247. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/

Rule: tier2.meta.no-twitter-card

https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/special-delivery-strands-get-your-favorite-cannabis-delivered-fast-from-terp-bros/
https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/
https://terpbrosnyc.com/top-5-things-to-do-on-ditmars-blvd-in-astoria-queens/
https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/
https://terpbrosnyc.com/the-complete-guide-to-camino-edibles/


Detail

No twitter:card meta tag.

248. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

249. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

250. Title length 68 chars

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Terp Bros Cannabis Delivery: Fast and Reliable in Queens – Terp Bros"

251. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

252. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/

Rule: tier2.meta.no-twitter-card

Detail

https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/
https://terpbrosnyc.com/weed-delivery-experience-convenience-with-terp-bros/
https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/
https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/
https://terpbrosnyc.com/terp-bros-cannabis-delivery-fast-and-reliable-in-queens/


No twitter:card meta tag.

253. Title length 72 chars

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Astoria Dispensary: 5 Reasons to Experience Quality Cannabis – Terp Bros"

254. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

255. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

256. Title length 70 chars

Severity: P3

Page URL: https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Nanticoke Cannabis Brand: Cultivating a Legacy in New York – Terp Bros"

257. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/
https://terpbrosnyc.com/astoria-dispensary-5-reasons-to-experience-quality-cannabis/
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258. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

259. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

260. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

261. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

262. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/our-toke-nyc-issa-vibe-cannabis-brand/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/nanticoke-cannabis-brand-cultivating-a-legacy-in-new-york/
https://terpbrosnyc.com/our-toke-nyc-zizzle-cannabis-brand/
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263. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/420-photo-recap/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

264. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/420-photo-recap/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

265. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

266. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

267. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/vegan-love-joint-recap-photos/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/420-photo-recap/
https://terpbrosnyc.com/420-photo-recap/
https://terpbrosnyc.com/last-wednesday-in-queens-with-renarts-recap/
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268. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/vegan-love-joint-recap-photos/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

269. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

270. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

271. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

272. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/queens-cannabis-culture-terp-bros-leading-the-way/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/vegan-love-joint-recap-photos/
https://terpbrosnyc.com/rediscovering-the-legend-aj-sour-diesel/
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273. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

274. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

275. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

276. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/understanding-cannabis-terpenes-a-guide-by-terp-bros/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

277. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/a-first-time-buyers-guide-to-cannabis-at-terp-bros/
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278. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/hall-of-flowers-x-honey-suckle-after-party/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

279. Title length 67 chars

Severity: P3

Page URL: https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Carmelo Anthony Launches stay Melo at Terp Bros Astoria – Terp Bros"

280. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

281. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

282. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/queens-fight-club-press-conference/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/
https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/
https://terpbrosnyc.com/carmelo-anthony-launches-stay-melo-at-terp-bros-astoria/
https://terpbrosnyc.com/queens-fight-club-press-conference/


283. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/queens-fight-club-press-conference/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

284. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

285. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

286. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

287. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/queens-fight-club-press-conference/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms/
https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-truffles-a-terp-bros-newsletter/


288. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

289. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

290. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

291. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

292. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-great-melt-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-treasures-a-terp-bros-newsletter/
https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/


293. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

294. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

295. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

296. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

297. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/blizzard-bounce-back-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-volume-2-a-terp-bros-newsletter/
https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/
https://terpbrosnyc.com/terp-of-the-morning-a-terp-bros-newsletter/


298. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

299. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

300. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

301. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

302. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/
https://terpbrosnyc.com/waning-winter-a-terp-bros-newsletter/
https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/
https://terpbrosnyc.com/schnitzel-story-a-terp-bros-newsletter/
https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/


303. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

304. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

305. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

306. Title length 9 chars

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Terp Bros"

307. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/munchie-madness-part-trois-a-terp-bros-munchletter/
https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/
https://terpbrosnyc.com/episode-4-20-a-terp-bros-newsletter/
https://terpbrosnyc.com/
https://terpbrosnyc.com/


308. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

309. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/our-story/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

310. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/our-story/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

311. Title length 16 chars

Severity: P3

Page URL: https://terpbrosnyc.com/blog/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Blog – Terp Bros"

312. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/
https://terpbrosnyc.com/our-story/
https://terpbrosnyc.com/our-story/
https://terpbrosnyc.com/blog/
https://terpbrosnyc.com/blog/


313. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

314. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/contact-us/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

315. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/contact-us/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

316. Title length 16 chars

Severity: P3

Page URL: https://terpbrosnyc.com/faqs/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "FAQS – Terp Bros"

317. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/faqs/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/blog/
https://terpbrosnyc.com/contact-us/
https://terpbrosnyc.com/contact-us/
https://terpbrosnyc.com/faqs/
https://terpbrosnyc.com/faqs/


318. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/faqs/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

319. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

320. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

321. Title length 19 chars

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Astoria – Terp Bros"

322. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/faqs/
https://terpbrosnyc.com/ozone-park/
https://terpbrosnyc.com/ozone-park/
https://terpbrosnyc.com/astoria/
https://terpbrosnyc.com/astoria/


323. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

324. Title length 18 chars

Severity: P3

Page URL: https://terpbrosnyc.com/flower/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Flower – Terp Bros"

325. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

326. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

327. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/astoria/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/cannabis-delivery/


328. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

329. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/in-store-pick-up/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

330. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/in-store-pick-up/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

331. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/online-ordering/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

332. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/online-ordering/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/cannabis-delivery/
https://terpbrosnyc.com/in-store-pick-up/
https://terpbrosnyc.com/in-store-pick-up/
https://terpbrosnyc.com/online-ordering/
https://terpbrosnyc.com/online-ordering/


333. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/loyalty-program/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

334. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/loyalty-program/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

335. Title length 17 chars

Severity: P3

Page URL: https://terpbrosnyc.com/press/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Press – Terp Bros"

336. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/press/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

337. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/press/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/loyalty-program/
https://terpbrosnyc.com/loyalty-program/
https://terpbrosnyc.com/press/
https://terpbrosnyc.com/press/
https://terpbrosnyc.com/press/


338. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/about-us/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

339. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/about-us/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

340. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-101/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

341. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/cannabis-101/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

342. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/recreational-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/about-us/
https://terpbrosnyc.com/about-us/
https://terpbrosnyc.com/cannabis-101/
https://terpbrosnyc.com/cannabis-101/
https://terpbrosnyc.com/recreational-cannabis/


343. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/recreational-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

344. Title length 18 chars

Severity: P3

Page URL: https://terpbrosnyc.com/jeeter/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jeeter – Terp Bros"

345. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/jeeter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

346. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/jeeter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

347. Title length 16 chars

Severity: P3

Page URL: https://terpbrosnyc.com/mfny/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "MFNY – Terp Bros"

https://terpbrosnyc.com/recreational-cannabis/
https://terpbrosnyc.com/jeeter/
https://terpbrosnyc.com/jeeter/
https://terpbrosnyc.com/jeeter/
https://terpbrosnyc.com/mfny/


348. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/mfny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

349. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/mfny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

350. Title length 16 chars

Severity: P3

Page URL: https://terpbrosnyc.com/puff/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Puff – Terp Bros"

351. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/puff/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

352. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/puff/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/mfny/
https://terpbrosnyc.com/mfny/
https://terpbrosnyc.com/puff/
https://terpbrosnyc.com/puff/
https://terpbrosnyc.com/puff/


353. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/dank-by-definition/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

354. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/dank-by-definition/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

355. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/nanticoke/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

356. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/nanticoke/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

357. Title length 16 chars

Severity: P3

Page URL: https://terpbrosnyc.com/olio/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Olio – Terp Bros"

https://terpbrosnyc.com/dank-by-definition/
https://terpbrosnyc.com/dank-by-definition/
https://terpbrosnyc.com/nanticoke/
https://terpbrosnyc.com/nanticoke/
https://terpbrosnyc.com/olio/


358. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/olio/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

359. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/olio/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

360. Title length 17 chars

Severity: P3

Page URL: https://terpbrosnyc.com/jetty/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jetty – Terp Bros"

361. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/jetty/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

362. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/jetty/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/olio/
https://terpbrosnyc.com/olio/
https://terpbrosnyc.com/jetty/
https://terpbrosnyc.com/jetty/
https://terpbrosnyc.com/jetty/


363. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/back-home-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

364. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/back-home-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

365. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

366. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

367. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/back-home-cannabis/
https://terpbrosnyc.com/back-home-cannabis/
https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/
https://terpbrosnyc.com/ozone-park/howard-beach-lindenwood-weed-delivery/
https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/


368. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

369. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

370. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

371. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

372. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/ozone-park/richmond-hill-little-guyana-weed-delivery/
https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/
https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/
https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/
https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/


373. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

374. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

375. Title length 75 chars

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/dispensary-near-me/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Best Legal Cannabis Dispensary and Weed Delivery in Astoria – Terp

Bros"

376. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/dispensary-near-me/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

377. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/dispensary-near-me/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/
https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/
https://terpbrosnyc.com/astoria/dispensary-near-me/
https://terpbrosnyc.com/astoria/dispensary-near-me/
https://terpbrosnyc.com/astoria/dispensary-near-me/


378. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

379. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

380. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

381. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

382. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/
https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/
https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/
https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/
https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/


383. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

384. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

385. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

386. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

387. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/
https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/
https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/
https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/
https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/


388. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

389. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

390. 1 image(s) missing alt text

Severity: P3

Page URL: https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

391. Title length 16 chars

Severity: P3

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Blog – Terp Bros"

392. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/
https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/
https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-398c502-99/
https://terpbrosnyc.com/category/blog/
https://terpbrosnyc.com/category/blog/


393. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/category/blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

394. Missing OpenGraph metadata

Severity: P3

Page URL: https://terpbrosnyc.com/author/servicebudauthority-com/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

395. Missing Twitter card

Severity: P3

Page URL: https://terpbrosnyc.com/author/servicebudauthority-com/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

396. Heavy JS payload (mobile): 276KB

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier3.weight.js-mobile

Detail

JavaScript transfer exceeds 250KB budget.

397. Heavy page weight (mobile): 8553KB

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier3.weight.total-mobile

Detail

Total transfer exceeds 2500KB budget.

https://terpbrosnyc.com/category/blog/
https://terpbrosnyc.com/author/servicebudauthority-com/
https://terpbrosnyc.com/author/servicebudauthority-com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/


398. Heavy JS payload (desktop): 434KB

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier3.weight.js-desktop

Detail

JavaScript transfer exceeds 250KB budget.

399. Heavy page weight (desktop): 8650KB

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier3.weight.total-desktop

Detail

Total transfer exceeds 2500KB budget.

400. SSL Labs grade: unknown

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.

401. DNSSEC not enabled

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

402. No CAA DNS records

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier5.fortress.caa-missing

Detail

CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/
https://terpbrosnyc.com/


403. Lighthouse seo (mobile): 92/100

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lighthouse.seo-mobile

Detail

Score 92 is below target 95. See HTML report for details.

404. LH mobile: Preconnect to required origins (Est savings of 440 ms)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-mobile

Detail

Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

405. LH mobile: Preload Largest Contentful Paint image

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.prioritize-lcp-image-mobile

Detail

If the LCP element is dynamically added to the page, you should preload the image in order to improve LCP.

https://web.dev/articles/optimize-lcp#optimize_when_the_resource_is_discovered" target="_blank"

rel="noreferrer">Learn more about preloading LCP elements.

406. LH mobile: Defer offscreen images (Est savings of 137 KiB)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.offscreen-images-mobile

Detail

Consider lazy-loading offscreen and hidden images after all critical resources have finished loading to lower

time to interactive. https://developer.chrome.com/docs/lighthouse/performance/offscreen-images/"

target="_blank" rel="noreferrer">Learn how to defer offscreen images.

407. LH mobile: Eliminate render-blocking resources (Est savings of

4,800 ms)

Severity: P3

https://terpbrosnyc.com/
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=


Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.render-blocking-resources-mobile

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

408. LH mobile: Minify CSS (Est savings of 2 KiB)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.unminified-css-mobile

Detail

Minifying CSS files can reduce network payload sizes.

https://developer.chrome.com/docs/lighthouse/performance/unminified-css/" target="_blank"

rel="noreferrer">Learn how to minify CSS.

409. Lighthouse seo (desktop): 92/100

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lighthouse.seo-desktop

Detail

Score 92 is below target 95. See HTML report for details.

410. LH desktop: Preconnect to required origins (Est savings of 230 ms)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-desktop

Detail

Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

411. LH desktop: Preload Largest Contentful Paint image

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.prioritize-lcp-image-desktop

Detail

https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/


If the LCP element is dynamically added to the page, you should preload the image in order to improve LCP.

https://web.dev/articles/optimize-lcp#optimize_when_the_resource_is_discovered" target="_blank"

rel="noreferrer">Learn more about preloading LCP elements.

412. LH desktop: Defer offscreen images (Est savings of 137 KiB)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.offscreen-images-desktop

Detail

Consider lazy-loading offscreen and hidden images after all critical resources have finished loading to lower

time to interactive. https://developer.chrome.com/docs/lighthouse/performance/offscreen-images/"

target="_blank" rel="noreferrer">Learn how to defer offscreen images.

413. LH desktop: Eliminate render-blocking resources (Est savings of

360 ms)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.render-blocking-resources-desktop

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

414. LH desktop: Minify CSS (Est savings of 2 KiB)

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier8.lh-opportunity.unminified-css-desktop

Detail

Minifying CSS files can reduce network payload sizes.

https://developer.chrome.com/docs/lighthouse/performance/unminified-css/" target="_blank"

rel="noreferrer">Learn how to minify CSS.

415. A11y: ARIA role should be appropriate for the element

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier9.a11y.aria-allowed-role

Detail

Ensure role attribute has an appropriate value for the element

file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Terp%20Bros%20NYC/%3Ca%20href=
https://terpbrosnyc.com/


Impact: minor

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/aria-allowed-role?application=playwright

416. Dutchie menu iframe not found on /, /menu, or /shop

Severity: P3

Page URL: https://terpbrosnyc.com/

Rule: tier-revenue.dutchie.iframe-absent

Detail

No Dutchie iframe detected. If this client uses a different menu provider, add it to clients.yaml dutchieSlug=null

+ we'll stop flagging.

Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://terpbrosnyc.com/

_39 findings on this page_

[P1] Lighthouse perf (mobile): 33/100 🔴  DO FIRST

Your mobile site takes 21.5 seconds for the largest visual element to appear on screen (Largest Contentful

Paint), when Google targets under 2.5 seconds. This delay happens because heavy images, unopt

[P1] Lighthouse bestPractices (mobile): 57/100 🟠  HIGH

Your mobile site's Lighthouse Best Practices score is 57/100, meaning it's failing several web standards that

affect user trust, security, and browser compatibility. Common culprits include unoptimize

[P1] Lighthouse bestPractices (desktop): 59/100 🟠  HIGH

Your site's Lighthouse Best Practices score is 59 out of 100, well below the healthy target of 90. Lighthouse

audits check for issues like outdated JavaScript libraries, missing security headers, depr

[P1] A11y: ARIA dialog and alertdialog nodes should have an accessible name 🔴  DO FIRST

Your age-gate popup (the overlay that appears when visitors arrive) is missing a label that screen reader users

can understand. Screen readers announce dialog boxes to assistive technology users, but

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 48 image(s) missing alt text

[P2] Slow LCP (desktop): 1916ms

[P2] Missing core schema types: Organization, LocalBusiness, WebSite

[P2] Missing security header: content-security-policy

[P2] 11 tap targets under 44px at mobile-320

https://dequeuniversity.com/rules/axe/4.11/aria-allowed-role?application=playwright
https://terpbrosnyc.com/
https://terpbrosnyc.com/


[P2] 11 tap targets under 44px at mobile-375

[P2] 11 tap targets under 44px at mobile-414

[P2] 15 tap targets under 44px at tablet-768

[P2] Lighthouse perf (desktop): 70/100

[P3] Title length 9 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] Heavy JS payload (mobile): 276KB

[P3] Heavy page weight (mobile): 8553KB

[P3] Heavy JS payload (desktop): 434KB

[P3] Heavy page weight (desktop): 8650KB

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] Lighthouse seo (mobile): 92/100

[P3] LH mobile: Preconnect to required origins (Est savings of 440 ms)

[P3] LH mobile: Preload Largest Contentful Paint image

[P3] LH mobile: Defer offscreen images (Est savings of 137 KiB)

[P3] LH mobile: Eliminate render-blocking resources (Est savings of 4,800 ms)

[P3] LH mobile: Minify CSS (Est savings of 2 KiB)

[P3] Lighthouse seo (desktop): 92/100

[P3] LH desktop: Preconnect to required origins (Est savings of 230 ms)

[P3] LH desktop: Preload Largest Contentful Paint image

[P3] LH desktop: Defer offscreen images (Est savings of 137 KiB)

[P3] LH desktop: Eliminate render-blocking resources (Est savings of 360 ms)

[P3] LH desktop: Minify CSS (Est savings of 2 KiB)

[P3] A11y: ARIA role should be appropriate for the element

[P3] Dutchie menu iframe not found on /, /menu, or /shop

https://terpbrosnyc.com/category/blog/

_7 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 16 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-

bros-newsletter/

https://terpbrosnyc.com/category/blog/
https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/its-beginning-to-look-a-lot-like-terpmas-a-terp-bros-newsletter/


_6 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your blog post about Terpmas doesn't include a meta description — the 150–160 character summary that

appears below the page title in Google search results. Without it, Google generates a random snippe

[P2] No JSON-LD schema 🟠  HIGH

Your site doesn't include JSON-LD structured data—machine-readable code that tells Google what your pages

are about (e.g., "this is a blog post", "this is a product", "this location has business hours

[P2] 7 image(s) missing alt text 🟡  MEDIUM

Every image on your site should have descriptive alt text — a short text description that explains what the image

shows. This text is read aloud by screen readers for visitors with low vision, and it

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-

presents-the-lightupmbc/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page is missing a meta description — the 155-character summary that appears below your page

title in Google search results. Without it, Google generates a random excerpt from your page

[P2] No JSON-LD schema 🟠  HIGH

Your event page doesn't include JSON-LD structured data — machine-readable code that tells Google what the

page is about (in this case, an event). Without it, search engines have to guess, which means

[P2] 7 image(s) missing alt text 🟠  HIGH

All 7 images on this event page lack alt text—short descriptions that screen readers read aloud to blind/low-

vision visitors, and that search engines use to understand image content. Without alt text,

[P3] Title length 78 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-

newsletter/

_6 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your blog post about Bavarian Pretzels doesn't have a meta description — a 160-character summary that

appears below your page title in Google search results. Without it, Google will auto-generate a sn

[P2] No JSON-LD schema 🟡  MEDIUM

https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/
https://terpbrosnyc.com/5th-annual-miles-for-mbc-and-kelly-marie-presents-the-lightupmbc/
https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/
https://terpbrosnyc.com/bavarian-pretzels-block-parties-a-terp-bros-newsletter/


Your blog post pages don't include JSON-LD structured data—a machine-readable format that tells Google

what your content is about (e.g., a news article, event, product). Without it, search engines hav

[P2] 7 image(s) missing alt text 🟠  HIGH

Every image on your website should have alt text — a short text description that screen readers read aloud to

visually impaired visitors, and that search engines use to understand what the image shows

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-

with-boris-jordan/

_6 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Meta descriptions are the 2–3 sentence summaries that appear below your page title in Google search results.

This blog post about a Curaleaf conversation is missing that description, so Google will au

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 75 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/sweater-weather-but-not-really-a-terp-bros-

newsletter/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/stiiizys-roots-discovering-the-visionaries-who-

built-the-brand/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

https://terpbrosnyc.com/ny-state-of-mind-with-curaleaf-conversation-with-boris-jordan/
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[P2] No JSON-LD schema

[P2] 5 image(s) missing alt text

[P3] Title length 16 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 39 image(s) missing alt text

[P3] Title length 19 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/flower/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 22 image(s) missing alt text

[P3] Title length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/press/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 17 image(s) missing alt text

[P3] Title length 17 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/faqs/
https://terpbrosnyc.com/astoria/
https://terpbrosnyc.com/flower/
https://terpbrosnyc.com/press/


https://terpbrosnyc.com/jeeter/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/mfny/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 16 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/puff/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 16 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/olio/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 16 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/jetty/

_6 findings on this page_

https://terpbrosnyc.com/jeeter/
https://terpbrosnyc.com/mfny/
https://terpbrosnyc.com/puff/
https://terpbrosnyc.com/olio/
https://terpbrosnyc.com/jetty/


[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Title length 17 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/dispensary-near-me/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 12 image(s) missing alt text

[P3] Title length 75 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/author/servicebudauthority-com/

_6 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P2] 8 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your newsletter page (/frozen-fire-a-terp-bros-newsletter/) is missing a meta description — a 150-160

character summary that appears below your page title in Google search results. Without one, Google

[P2] No JSON-LD schema 🟠  HIGH

Your product pages and content don't include JSON-LD schema markup — a standardized format that tells

Google what your pages are about (e.g., product name, price, reviews). Without it, search engines

[P2] 5 image(s) missing alt text 🟠  HIGH

All 5 images on this newsletter page are missing alt text — short descriptions that screen readers read aloud to

blind or low-vision visitors, and that search engines use to understand what images sho

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/dispensary-near-me/
https://terpbrosnyc.com/author/servicebudauthority-com/
https://terpbrosnyc.com/frozen-fire-a-terp-bros-newsletter/


https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page doesn't have a meta description—the 160-character summary that appears below the page

title in Google search results. Without it, Google generates one automatically from your page

[P2] No JSON-LD schema 🟠  HIGH

Your site is not publishing machine-readable information about your content (like article titles, publication

dates, or author details) in a format that Google and other search engines can easily unde

[P2] 5 image(s) missing alt text 🟠  HIGH

Your blog post about the January newsletter has 5 images that lack descriptive alt text (alternative text that

describes what's in the image). Screen readers—software that reads websites aloud for vis

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post page doesn't have a meta description — a 150-160 character summary that appears in Google

search results. Without it, Google generates a snippet automatically, which often cuts off awkw

[P2] No JSON-LD schema 🟠  HIGH

Your site has no JSON-LD structured data, which is code that tells search engines what your pages are about.

Without it, Google can't easily understand whether a page is a product listing, a news arti

[P2] 5 image(s) missing alt text 🟠  HIGH

All 5 images on this page are missing alt text — the hidden descriptions that screen readers use to tell

blind/low-vision visitors what an image shows, and that search engines use to understand image

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This page is missing a meta description — the 150-160 character snippet that appears below the page title in

Google search results. Without it, Google generates a random excerpt from your content, whi

[P2] No JSON-LD schema 🟠  HIGH

Your site is not using JSON-LD (a structured data format that search engines read to understand page content).

Right now, Google has to guess what your pages are about based on text alone. Adding JSON

[P2] 7 image(s) missing alt text 🟠  HIGH

https://terpbrosnyc.com/high-january-a-terp-bros-newsletter/
https://terpbrosnyc.com/happy-terp-year-a-terp-bros-newsletter/
https://terpbrosnyc.com/ho-ho-bro-a-terp-bros-newsletter/


Seven images on your newsletter page lack alt text — descriptive labels that screen readers use to tell visually

impaired visitors what an image shows. This also means search engines can't understand

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post page is missing a meta description — a 150-160 character summary that appears below the page

title in Google search results. Without it, Google generates a random excerpt from your page

[P2] No JSON-LD schema 🟠  HIGH

Your website is missing JSON-LD structured data — machine-readable code that tells Google and other search

engines what your content is about. Without it, search engines have to guess whether a page i

[P2] 5 image(s) missing alt text 🟠  HIGH

Every image on your website should have a text description (called 'alt text') that explains what the image

shows. Right now, 5 images on your newsletter page have no description. Screen readers — too

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post page is missing a meta description—the 155-character summary that appears below your page

title in Google search results. Without it, Google generates a random snippet from your page co

[P2] No JSON-LD schema 🟠  HIGH

Your blog post pages don't include JSON-LD structured data—machine-readable code that tells Google what

your content is about (e.g., article title, author, publish date). Without it, search engines ha

[P2] 7 image(s) missing alt text 🟠  HIGH

Your blog post has 7 images that lack alt text—a short text description that appears when images don't load and

helps search engines understand what the image shows. This makes the page harder for peo

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your newsletter page doesn't have a meta description — the 160-character summary that appears below your

page title in Google search results. Without one, Google generates a random snippet from your p

https://terpbrosnyc.com/frozen-3-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-year-of-the-terp-a-terp-bros-newsletter-2/
https://terpbrosnyc.com/the-slow-melt-a-terp-bros-newsletter/


[P2] No JSON-LD schema 🟠  HIGH

Your site is not using JSON-LD (a machine-readable format that tells Google, Bing, and other search engines

what your content is about). Search engines have to guess the meaning of your pages by readi

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter page lack alt text — descriptive labels that screen readers use to tell

blind/low-vision visitors what an image shows. Search engines also use alt text to understand im

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-

newsletter/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page doesn't have a meta description—the 155-character summary that appears below the page

title in Google search results. Without it, Google generates a random snippet from your conten

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter post have no descriptive text (called 'alt text'). This means screen readers

used by visually impaired customers can't describe those images, and search engines can't u

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-

newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your blog post about the Christmas newsletter is missing a meta description—the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter page have no alternative text descriptions. Alt text is read aloud by screen

readers used by people with vision disabilities, and it also helps search engines understan

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/black-friday-at-terp-bros/

_5 findings on this page_

https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/
https://terpbrosnyc.com/the-day-after-terpmorrow-a-terp-bros-newsletter/
https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/blue-and-yellow-christmas-a-terp-bros-newsletter/
https://terpbrosnyc.com/black-friday-at-terp-bros/


[P2] Missing meta description 🟡  MEDIUM

Your Black Friday promotion page doesn't have a meta description — that's the 160-character summary that

appears below your page title in Google search results. Without it, Google generates a random s

[P2] No JSON-LD schema 🟠  HIGH

Your site isn't using JSON-LD structured data — a standardized format that tells search engines what your

pages are about in a machine-readable way. Think of it like labeling your storefront clearly s

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your Black Friday page don't have alt text—short descriptions that tell screen readers and

search engines what each image shows. This means visually impaired customers can't understand

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/green-wednesday-at-terp-bros/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post about Green Wednesday doesn't have a meta description — the short summary (usually 155–160

characters) that appears under your link in Google search results. Without it, Google generate

[P2] No JSON-LD schema 🟠  HIGH

Your site is not using JSON-LD (a standardized way to tell search engines what your content is about in

machine-readable format). This means Google has to guess whether a page is a product listing, a

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your thank-you page after newsletter signup is missing a meta description — the 160-character summary that

appears below your page title in Google search results. Without it, Google may auto-generate

[P2] No JSON-LD schema 🟠  HIGH

Your website doesn't include JSON-LD structured data — machine-readable code that tells search engines what

your pages are about. Without it, Google can't easily understand your content, product listi

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter thank-you page don't have alt text—descriptive labels that explain what each

image shows. Search engines can't read images, so without alt text, those images are invisi

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/green-wednesday-at-terp-bros/
https://terpbrosnyc.com/thanks-for-giving-a-terp-bros-newsletter/


https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your page about the Ozone Park newsletter is missing a meta description — a 155-character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a sn

[P2] No JSON-LD schema 🟠  HIGH

Your website isn't marking up its content with structured data — a machine-readable label that tells Google

what your pages are about. For a dispensary, this means Google can't automatically recognize

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter page don't have alt text — descriptive labels that tell search engines and

screen readers (software that reads pages aloud for visually impaired users) what each image

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This page doesn't have a meta description — the 160-character summary that appears under your page title in

Google search results. Without it, Google generates a random excerpt from your page content,

[P2] No JSON-LD schema 🟠  HIGH

Your website doesn't include JSON-LD structured data—a machine-readable format that tells Google and other

search engines what your pages are about. For a cannabis retail site, this means search engin

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter page don't have alt text—descriptive labels that screen readers read aloud to

visually impaired visitors and that search engines use to understand image content. This m

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post page doesn't include a meta description — a 155-character summary that appears below your

page title in Google search results. Without it, Google generates a random snippet from your co

[P2] No JSON-LD schema 🟡  MEDIUM

Your site is missing JSON-LD structured data — invisible code that tells Google what your pages are about. For

a blog post like 'Muchie Madness,' search engines can't automatically understand it's an

[P2] 7 image(s) missing alt text 🟠  HIGH

https://terpbrosnyc.com/terp-bros-ozone-park-newsletter-1/
https://terpbrosnyc.com/run-for-it-a-terp-bros-newsletter/
https://terpbrosnyc.com/muchie-madness-a-terp-bros-munchletter/


Seven images on your Muchie Madness article have no alternative text descriptions. Alt text is read aloud by

screen readers (tools blind customers use to browse the web) and helps search engines under

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post page is missing a meta description — the 155-character summary that appears under the page

title in Google search results. Without it, search engines will auto-generate a snippet, which

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post pages are missing structured data — machine-readable code that tells Google what type of

content is on the page (in this case, a blog article). Without it, search engines have to guess

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter post have no alt text—descriptive text that explains what each image shows.

Search engines and screen readers (used by people with vision loss) can't understand these i

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post page doesn't have a meta description — the short text snippet that appears below your page title

in Google search results. Without it, Google generates one automatically, which is often

[P2] No JSON-LD schema 🟠  HIGH

Your website doesn't include JSON-LD structured data—a machine-readable format that tells Google what your

pages are about (e.g., 'this is a blog post about a product' or 'this is a dispensary locatio

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page is missing a meta description — the 150–160 character summary that appears below your

page title in Google search results. Without it, Google will auto-generate a snippet from your

[P2] No JSON-LD schema 🟠  HIGH

https://terpbrosnyc.com/tacos-time-capsules-a-terp-bros-newsletter/
https://terpbrosnyc.com/hotel-terpsylvania-a-terp-bros-newsletter/
https://terpbrosnyc.com/fried-chicken-bliss-a-terp-bros-newsletter/


Your site doesn't include JSON-LD structured data — machine-readable code that tells Google what type of

content lives on each page (a product, article, local business, etc.). Without it, search engin

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post about your Forest Hills Kiwanis networking event is missing a meta description—the short text

(150–160 characters) that appears under your page title in Google search results. Without i

[P2] No JSON-LD schema

[P2] 8 image(s) missing alt text 🟠  HIGH

Every image on your website needs descriptive text (called 'alt text') that explains what the image shows.

Search engines and screen readers used by people with visual impairments rely on this text. R

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page about your newsletter doesn't have a meta description — the 150-160 character summary that

appears below the page title in Google search results. Without it, Google generates a random excerp

[P2] No JSON-LD schema 🟠  HIGH

Your website is missing JSON-LD structured data—machine-readable labels that tell Google what your content

is about. Right now, search engines have to guess. For a cannabis community site, this means

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your newsletter page lack descriptive alt text — the hidden text that describes what an image

shows. This means screen reader users (people who are blind or have low vision) hear nothi

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

https://terpbrosnyc.com/forest-hills-kiwanis-business-networking-event/
https://terpbrosnyc.com/season-of-the-terp-a-terp-bros-newsletter/
https://terpbrosnyc.com/terps-seafood-sunshine-a-terp-bros-newsletter/


[P3] Missing Twitter card

https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 8 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

https://terpbrosnyc.com/live-laugh-loud-a-terp-bros-newsletter/
https://terpbrosnyc.com/riverheads-green-gems-a-tour-of-local-farms-2/
https://terpbrosnyc.com/get-the-scoop-on-rootbeer-freeze-cannabis/
https://terpbrosnyc.com/rain-rain-terp-away-an-early-fall-newsletter/
https://terpbrosnyc.com/terp-the-power-a-terp-bros-newsletter/


[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-

the-hype/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-

bong/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-

ny/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/
https://terpbrosnyc.com/green-crack-disposable-pens-are-they-worth-the-hype/
https://terpbrosnyc.com/steady-grinding-the-terp-bros-newsletter-story/
https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/
https://terpbrosnyc.com/say-goodbye-to-grime-easy-ways-to-clean-your-bong/
https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/
https://terpbrosnyc.com/where-to-find-the-freshest-blooms-in-amherst-ny/


https://terpbrosnyc.com/terp-bros-skydiving-event/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 8 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/queens-fight-club-presented-by-terp-bros/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 10 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/summer-terpin-had-me-a-blast/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 7 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/sweet-escape-exploring-cannabis-magic-mango-

gummies/
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[P2] 11 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/ozone-park/rockaways-weed-delivery/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 11 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/ozone-park/closest-dispensary-to-jfk-airport/

_5 findings on this page_

https://terpbrosnyc.com/back-home-cannabis/
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[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 12 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-

casino-aqueduct/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 10 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 11 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 9 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/
https://terpbrosnyc.com/ozone-park/dispensary-near-resorts-world-casino-aqueduct/
https://terpbrosnyc.com/astoria/long-island-city-weed-delivery/
https://terpbrosnyc.com/astoria/woodside-sunnyside-weed-delivery/
https://terpbrosnyc.com/astoria/astoria-park-ralph-demarco-dispensary/


https://terpbrosnyc.com/astoria/closest-dispensary-to-lga-airport/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 10 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/astoria/n-w-trains-weed-dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 10 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://terpbrosnyc.com/elementskit-content/dynamic-content-widget-

398c502-99/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://terpbrosnyc.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress login page (/wp-login.php) is publicly accessible and shows a 200 response, meaning anyone

on the internet can find and attempt to access your admin panel. While this is a common WordPr
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